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Процедуры по обслуживанию устройства могут выполняться только квалифицированным персоналом.

Во время работы с прибором может потребоваться доступ к другим компонентам системы. Прочтите разделы по
технике безопасности в руководствах по работе с другими компонентами и ознакомьтесь с мерами предосторожности
и предупреждениями, связанными с эксплуатацией системы.

Пожарная безопасность и предотвращение травм

Используйте соответствующий кабель питания. Подключение к электросети должно выполняться только
кабелем, разрешенным к использованию с данным изделием и сертифицированным для страны, в которой будет
производиться его эксплуатация.

Соблюдайте ограничения на параметры разъемов. Во избежание воспламенения или поражения
электрическим током проверьте все допустимые номиналы и маркировку на приборе. Перед подсоединением
прибора просмотрите дополнительные сведения по номинальным ограничениям, содержащиеся в руководстве к
прибору.

Входы не предназначены для подключения к электросети и цепям категорий II, III или IV.

Отключение питания. Отсоедините шнур питания прибора от источника питания. Не следует перекрывать
подход к шнуру питания; он должен всегда оставаться доступным для пользователя.

Не используйте прибор с открытым корпусом. Использование прибора со снятым кожухом или защитными
панелями не допускается.

Не пользуйтесь неисправным прибором. Если имеется подозрение, что прибор поврежден, передайте его
для осмотра специалисту по техническому обслуживанию.

Избегайте прикосновений к оголенным участкам проводки. Не прикасайтесь к неизолированным
соединениям и компонентам, находящимся под напряжением.

Соблюдайте правила замены батареи. Используйте только батареи, типы и номиналы которых соответствуют
требованиям данного прибора.

Соблюдайте правила перезарядки батарей. Перезаряжайте батареи только в течение рекомендуемого
цикла зарядки.

Используйте надлежащий адаптер переменного тока. Для данного прибора следует использовать только
предназначенный для него адаптер переменного тока.
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Не пользуйтесь прибором во взрывоопасных средах.

Условные обозначения в данном руководстве

Ниже приводится список условных обозначений, используемых в данном руководстве.

ПРЕДУПРЕЖДЕНИЕ. Предупреждения о действиях и условиях, представляющих угрозу для жизни или способных
нанести вред здоровью.

ОСТОРОЖНО. Предостережения о действиях и условиях, способных привести к повреждению данного прибора
или другого оборудования.

Символы и условные обозначения в данном руководстве

Ниже приводится список возможных обозначений на изделии.

Обозначение DANGER (Опасно!) указывает на непосредственную опасность получения травмы.

Обозначение WARNING (Внимание!) указывает на возможность получения травмы при отсутствии
непосредственной опасности.

Обозначение CAUTION (Осторожно!) указывает на возможность повреждения данного изделия и другого
имущества.

Ниже приводится список символов на изделии.
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Информация о соответствии

В этом разделе приводятся стандарты электромагнитной совместимости, безопасности и природоохранные
стандарты, которым соответствует данный прибор.

Соответствие требованиям по электромагнитной совместимости
Заявление о соответствии стандартам EC — электромагнитная совместимость

Отвечает требованиям директивы 2004/108/EC по электромагнитной совместимости. Проверено на соответствие
перечисленным ниже стандартам (как указано в издании «Official Journal of the European Communities»).

EN 61326-1:2006, EN 61326-2-1:2006. Требования по электромагнитной совместимости электрооборудования
для измерений, контроля и использования в лабораториях. 1 2 3 4

CISPR 11:2003. Обычные и наведенные излучения, группа 1, класс A

IEC 61000-4-2:2001. Защищенность от электростатических разрядов

IEC 61000-4-3:2002. Защищенность от электромагнитных радиочастотных полей 5

IEC 61000-4-4:2004. Защищенность от перепадов и всплесков напряжения

IEC 61000-4-5:2001. Защищенность от скачков напряжения в сети питания

IEC 61000-4-6:2003. Защищенность от наведенных радиочастотных помех 6

IEC 61000-4-11:2004. Защищенность от понижения и пропадания напряжения в сети питания 7

EN 61000-3-2:2006. Гармонические излучения сети переменного тока

EN 61000-3-3:1995. Изменения напряжения, флуктуации и фликкер-шум

Контактный адрес в Европе.
Tektronix UK, Ltd.
Western Peninsula,
Western Road,
Bracknell, RG12 1RF,
Великобритания

1 Прибор предназначен для использования только в нежилых помещениях. При использовании в жилых помещениях
следует учитывать, что прибор может быть источником электромагнитных помех.

2 При подключении оборудования к тестируемому объекту могут появиться излучения, превышающие уровни,
установленные данными стандартами.

3 Для обеспечения соответствия перечисленным стандартам по электромагнитной совместимости следует использовать
высококачественные экранированные кабели.

4 Когда применение теста с переходным электромагнитным процессом приводит к перезагрузке прибора, время
самовосстановления может превышать 10 секунд. Например, тест прерывания напряжения до 0 % на 250 циклов по
стандарту IEC 61000-4-11.

5 Остаточные паразитные сигналы могут достигать -30 дБм при воздействии на уровнях помех данного испытания.

6 Остаточные паразитные сигналы могут достигать -70 дБм при воздействии на уровнях помех данного испытания.

7 Критерий эффективности C применялся для тестовых уровней понижения напряжения до 70 % (25 циклов) и прерывания
напряжения до 0 % (250 циклов) (IEC 61000-4-11).
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Заявление о соответствии стандартам для Австралии/Новой Зеландии —
электромагнитная совместимость

Соответствует следующему стандарту электромагнитной совместимости для радиокоммуникаций в соответствии с
ACMA.

CISPR 11:2003. Обычные и наведенные излучения, группа 1, класс A, в соответствии с EN 61326-1:2006 и
EN 61326-2-1:2006.

Контактный адрес в Австралии/Новой Зеландии.
Baker & McKenzie,
Level 27, AMP Centre, 50 Bridge Street
Sydney NSW 2000, Австралия

Соответствие нормам безопасности
ANSI/UL61010-1:2004. Электрооборудование для измерений, контроля и лабораторного применения

CSA C22.2 No. 61010.1:2004. Электрооборудование для измерений, контроля и лабораторного применения

EN 61010-1:2001. Электрооборудование для измерений, контроля и лабораторного применения

IEC61010-1:2001. Электрооборудование для измерений, контроля и лабораторного применения

ISA 82.02.01. Электрооборудование для измерений, контроля и лабораторного применения

Требования к защите окружающей среды
В этом разделе содержатся сведения о влиянии прибора на окружающую среду.

Утилизация прибора по окончании срока службы

При утилизации прибора и его компонентов необходимо соблюдать следующие правила.

Утилизация оборудования. Для производства этого оборудования потребовалось извлечение и использование
природных ресурсов. Прибор может содержать вещества, опасные для окружающей среды и здоровья людей в
случае его неправильной утилизации по окончании срока службы. Во избежание утечки подобных веществ в
окружающую среду и для сокращения расхода природных ресурсов рекомендуется утилизировать данный прибор
таким образом, чтобы обеспечить максимально полное повторное использование материалов.

Этот символ означает, что данный прибор соответствует требованиям Европейского Союза согласно
директивам 2002/96/EC и 2006/66/EC об утилизации электрического и электронного оборудования
(WEEE) и элементов питания. Сведения об условиях утилизации см. в разделе технической поддержки
и обслуживания на веб-сайте Tektronix (www.tektronix.com).

Утилизация элементов питания. Литий-ионная аккумуляторная батарея данного прибора должна быть
утилизирована в установленном порядке.
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Утилизация и повторное использование литий-ионных батарей регулируются нормами, которые значительно
отличаются в разных странах и регионах. Перед утилизацией какого-либо элемента питания всегда сверяйтесь
с действующими нормами и следуйте им. В США и Канаде обращайтесь в корпорацию Rechargeable Battery
Recycling Corporation (www.rbrc.org), а других странах — в местную организацию, занимающуюся утилизацией
элементов питания.

Во многих странах запрещается выбрасывать вышедшее из строя электронное оборудование в обычные
мусорные контейнеры.

Отслужившие элементы питания выбрасывайте только в предназначенный для них контейнер. Используйте
изоляционную ленту или другую одобренную оболочку для защиты контактов элемента питания, чтобы
предотвратить их закорачивание.

Уведомление об использовании ртути. В приборе используется лампа подсветки жидкокристаллического
экрана, содержащая ртуть. Утилизация может регламентироваться законами об охране окружающей среды. За
сведениями об утилизации и повторном использовании материалов обращайтесь в местные органы власти.
Сведения, относящиеся к США, см. на веб-странице E-cycling Central (www.eiae.org).

Материалы, содержащие перхлорат. Этот продукт содержит один или несколько литиевых аккумуляторов
типа CR. В соответствии с законодательством штата Калифорния литиевые аккумуляторы типа CR входят в список
материалов, содержащих перхлорат, и требуют особого обращения. Дополнительные сведения см. на странице
www.dtsc.ca.gov/hazardouswaste/perchlorate.

Транспортировка литий-ионных аккумуляторов

Емкость литий-ионной аккумуляторной батареи в этом изделии составляет менее 100 Вт·ч. Эквивалентное
содержание лития, как было показано, удовлетворяет соответствующим требованиям, определенным в Руководстве
ООН по испытаниям и критериям, часть III, подраздел 38.3.

Всегда сверяйтесь со всеми применимыми местными, государственными и международными нормами перед
транспортировкой литий-ионного аккумулятора.

Транспортировка использованных, разрушенных или отозванных элементов питания в некоторых случаях
ограничивается или запрещается.

Во время транспортировки батарея должна быть в достаточной степени защищена от короткого замыкания
или повреждения.

Ограничение распространения опасных веществ

Этот продукт классифицирован как промышленный прибор для мониторинга и контроля и не должен соответствовать
ограничениям относительно определенных веществ согласно исправленной директиве RoHS 2011/65/ЕС до 22
июля 2017 г.

Руководство по эксплуатации SA2500 vii

http://www.dtsc.ca.gov/hazardouswaste/perchlorate


Предисловие

Предисловие

В данном руководстве приведены технические характеристики и описаны основные операции, выполняемые при
помощи анализатора спектра SA2500. Более подробную информацию о специфических областях применения и
решаемых задачах можно получить нажатием в приложении кнопок вызова разделов интерактивной справки по
интересующему предмету.

Основные функции
Прибор SA2500 представляет собой надежный, оптимизированный для применения в полевых условиях,
работающий в нескольких стандартах анализатор спектра, а также устройство отображения помех. Ниже
перечислены основные функции.

Входной диапазон частот анализатора спектра от 10 кГц до 6,2 ГГц, охватывающий частоты большинства
современных источников сигналов.

Цветной растровый дисплей DPX™ Spectrum, отображающий интенсивность поступления сигналов и изменения
формы кривой, что позволяет выделить характеристики сигналов малой длительности (выпускается опция
EP1 для повышения эффективности прибора DPX).

Нанесение результатов измерений непосредственно на карты с привязкой к местности (при помощи системы
GPS) или на карты с изображением местности для анализа на месте помех и проблем, связанных с зоной
покрытия.

Профили сигналов для анализа и классификации сигналов (необходима опция EP2).

Измерение зависимости амплитуды от времени (аналогично измерению в режиме временной развертки на
ПЧ-спектральном анализаторе сигналов с качающейся частотой).

Многочисленные маркеры сигналов, кривые сигналов и режимы кривых обеспечивают гибкие возможности для
проведения измерений.

Отображение спектрограммы для детектирования перемежающихся сигналов.

Основные измерения радиочастотных сигналов.

Документация
Тема Используйте следующие документы

Установка и эксплуатация (обзоры) Руководство по эксплуатации анализатора спектра SA2500. В
руководстве по эксплуатации содержится общая информация по
вводу прибора в эксплуатацию, описание элементов управления
пользовательского интерфейса и наиболее важные примеры применения.

Справка по использованию
приложения

Интерактивная справка. Интерактивная справка является
контекстно-зависимой и отображает информацию, соответствующую
активному экрану или выбранной кнопке справки.(См. стр. 16, Получение
справки.)
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Программное обеспечение прибора и ПК
Следующие обновления программного обеспечения прибора и программные средства для ПК доступны на веб-сайте
Tektronix (www.tektronix.com). Чтобы установить ПО прибора, необходимо иметь действительный программный ключ,
соответствующий серийному номеру прибора. Программные средства для ПК не требуют ключа активации.

Архивный файл обновления
программного обеспечения SA2500

Архивный файл обновления SA2500 позволяет обновить ПО прибора
SA2500 до последней версии.

Установочный файл приложения для ПК
SA2500

Программа моделирования SA2500 обеспечивает компьютерное
моделирование функциональных возможностей прибора. Программа
может отображать сохраненные результаты измерений, полученные
при помощи прибора, создавать и редактировать файлы для
тестирования с маской и т. д. Единственным ограничением этой
программы компьютерного моделирования является то, что она не
может проводить измерения.

Установочный файл приложения iMap
Converter для ПК

Компьютерная программа iMap Converter позволяет преобразовывать
карты с изображением местности или серийно выпускаемые
координатные сетки в файлы карт формата GSF с целью их
использования с функцией iMap прибора для привязки измерений
к карте. Программа iMap Converter позволяет также добавлять
координатную информацию в файлы с изображением местности
или создавать файлы с координатной сеткой из таких программ, как
Microsoft MapPoint.

Установочный файл приложения Signal
DB Editor для ПК

Редактор базы данных по сигналам позволяет редактировать файлы
базы данных по сигналам с целью уточнения параметров разрешения
сигналов.

Сервисная программа регистрации
ведомого устройства USB на ПК

Программа регистрации ведомого устройства USB позволяет
компьютеру вести обмен данными с прибором через кабель USB.
Чтобы удаленно управлять прибором через соединение USB, перед
использованием программы VirtualCE необходимо запустить эту
программу. Эту программу не требуется запускать в том случае,
если для удаленного управления прибором при помощи программы
VirtualCE используется сеть или соединение RS-232.

Установочный файл приложения VirtualCE
для ПК

Компьютерное приложение VirtualCE позволяет осуществлять
удаленное управление прибором с помощью виртуального
интерфейса на ПК или ноутбуке. Если для доступа к прибору из
приложения VirtualCE предполагается использовать кабель USB,
перед установкой и использованием этого приложения необходимо
запустить программу регистрации ведомого устройства USB.
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Загрузка программного обеспечения

1. С помощью веб-браузера посетите сайт www.tektronix.com/software.

2. Введите номер модели изделия (SA2500) в поле Search by keyword (Поиск по ключевому слову) и нажмите
кнопку Go (Перейти).

3. Прокрутите список и выберите ссылку на соответствующую программу, чтобы получить доступ к дополнительной
информации или загрузить программу.

Инструкции по установке программного обеспечения находятся на веб-странице, с которой загружается программа,
или включены в загружаемый файл.

Дополнительные возможности для измерений с помощью прибора
SA2500

Для расширения измерительных возможностей анализатора спектра SA2500 можно добавить дополнительные
опции из списка. Чтобы узнать, как прибрести и установить эти опции, обратитесь к местному представителю
компании Tektronix или зайдите на сайт www.tektronix.com.

SA2500 с опцией EP1 Опция EP1 добавляет к возможностям анализатора спектра SA2500
функцию повышенной скорости измерений для отображения спектра
DPX.

SA2500 с опцией EP2 Опция EP2 добавляет к возможностям анализатора спектра SA2500
классификацию сигнала в рамках стандартов связи и измерений базы
данных по сигналам.

Сведения об установке измерительных опций см. в разделе Диалоговое окно «Обновление опций программного
обеспечения» интерактивной справки.

Условные обозначения в данном руководстве
В данном руководстве используются следующие значки.

Действие
последоват-
ельности

Выключат-
ель питания
на передней
панели

Подключе-
ние электро-
питания
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Предотвращение травм от удара молнии

ПРЕДУПРЕЖДЕНИЕ. Во избежание получения травм вследствие удара молнии при использовании прибора
следует соблюдать следующие меры предосторожности.

Действия перед подключением прибора к любому источнику

Изучите местный прогноз погоды, выяснив вероятность грозы или молний.

Если погодные условия допускают возможность грозы или молний, следует чаще визуально контролировать
небо и следить за изменением погодных условий в вашей местности.

Если слышны раскаты грома и видны молнии, не подключайте прибор к источнику, который может быть
подвержен воздействиям молний.

При этом следует обращаться к своему опыту и здравому смыслу. Необходимо защищаться от воздействия
удара молнии.

Имейте в виду, что если прибор подключен к источнику, подверженному воздействию молнии, на его открытых
поверхностях будут присутствовать опасные напряжения. Изоляционное покрытие прибора не защитит вас
от этих опасных напряжений.

Не подключайте прибор к источнику, который может подвергнуться воздействию молнии

В случае грозовой обстановки в вашей местности следует учитывать следующее.

Если погодные условия в вашей местности могут привести к грозовым разрядам, существует риск попадания
молнии, до того как туча подойдет достаточно близко, чтобы можно было услышать раскаты грома или увидеть
сверкание молний.

Когда молния попадает в конструкцию или здание, ток проходит по арматуре, бетонным конструкциям, трубам,
кабелям, вентиляционным стоякам и электрической системе.

Молния может наводить электрические и магнитные поля на приборы и части электропроводки. Длина
проводника, подверженного воздействию магнитного поля в результате разряда молнии, может превышать три
километра.

Помните об опасности удара молнии, будьте внимательны

Когда молния попадает в проводник, который, в свою очередь, передает ток в область, находящуюся на
некотором расстоянии от точки удара молнии на земле, оборудование может быть повреждено, а персонал
может получить травмы, если они будут косвенным образом участвовать в замыкании цепи заземления.

По проводникам, таким как экранирующие оплетки кабелей или незащищенные провода, будут течь
значительные переходные токи в областях, подверженных воздействию электрического поля молнии.

Наведенные напряжения могут вызвать пробой изоляции в электропроводке около разъемов и в электрических
компонентах или пробой воздуха.
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Установка

Осторожно распакуйте прибор и проверьте наличие всех стандартных принадлежностей.

Стандартные принадлежности

Принадлежность
Номер по каталогу
Tektronix

Руководство по эксплуатации SA2500 077–0795-xx

Инструкции по обслуживанию литиево-ионных батарей в приборах H500, SA2500,
H600, SA2600, RF Scout, Y400 и Y350C

071-3117-xx

Адаптер переменного тока 119-7755-xx

Литиево-ионная батарея 146-0151-xx

Антенна GPS 119-7424-xx

Выдвижная опора 348-1661-xx

Мягкий футляр для переноски 016-1775-xx

Шнурок 016-1990-xx

Футляр с застежкой-молнией 016-1868-xx

Перо 119-6107-xx

УКВ-антенна системы контроля с разъемом BNC 119-6609-xx

Переходник N–BNC 103-0045-xx

2-метровый кабель USB, A–B 174-5611-xx

Штекер отключения гнезда аудиовыхода (отключает вывод звука из динамика
прибора)

131-8284-xx

В комплект поставки прибора могут также входить дополнительные принадлежности. Проверьте наличие заказанных
дополнительных принадлежностей. Текущий список доступных для конкретного прибора принадлежностей,
обновлений и опций, в том числе опций обслуживания, можно найти на веб-сайте компании Tektronix
(www.tektronix.com).

Условия эксплуатации

Адаптер
переменного тока

Входные напряжение и ток: 100–240 В переменного тока, 1,5 А
Входная частота: 50–60 Гц
Выходные напряжение и ток: 24 В постоянного тока, 2,7 А

Размеры Высота: 25,5 см
Ширина: 33 см
Глубина: 12,5 см

Масса Масса: 6,0 кг, прибор с одной аккумуляторной батареей

Диапазон
температур

При эксплуатации: от 0 до 50 °C номинальная характеристика, от -10 до +50 °C
типичная
При хранении: от -40 до +60 ℃
При зарядке аккумуляторной батареи: ограничено от 0 до 45 °C
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Влажность Рабочая и при хранении: относительная влажность от 5 до 95 % при температуре до 30 °C,
от 5 до 45 % при температуре от 30 до 50 °C, без конденсации

Высота над уровнем
моря

При эксплуатации: до 4600 м
При хранении: до 12 192 м

Вход РЧ-сигнала Диапазон частот входного сигнала: от 10 кГц до 6,2 ГГц
Тип входа: емкостный
Входное сопротивление: 50 Ом (номинал)
Максимальная входная мощность без повреждения прибора: 50 Вт ср. кв. при
10 кГц–3,2 ГГц, 15 Вт ср. кв. при 3,2–6,2 ГГц

Чистка

Чистка внешних поверхностей прибора выполняется сухой тканью, не оставляющей ворса, или мягкой щеткой.

Для чистки прибора или сенсорного экрана следует использовать ткань или тампон, смоченные в
деионизированной или дистиллированной воде, а в случае стойкого загрязнения — в 75-процентном растворе
изопропилового спирта; используйте влаги не более, чем это необходимо для увлажнения ткани или тампона.

При чистке сенсорного экрана не прикладывайте усилий.

ОСТОРОЖНО. При чистке наружной поверхности не позволяйте влаге проникать внутрь прибора.

Не промывайте выключатель On/Standby (Включение/ожидание) на передней панели. Закрывайте выключатель
во время влажной чистки прибора.

Не распыляйте жидкость непосредственно на прибор или сенсорный экран.

Не пользуйтесь абразивными чистящими веществами или химическими чистящими средствами, содержащими
бензол, толуол, ксилол, ацетон или аналогичные растворители. Они могут повредить прибор или сенсорный
экран. Не производите чистку сенсорного экрана промышленными средствами для чистки стекол.

При чистке сенсорного экрана не прикладывайте чрезмерных усилий.

Установка аккумуляторных батарей
В стандартной комплектации прибор поставляется с одной аккумуляторной батареей, которая не установлена в
прибор в период транспортировки. Чтобы установить батарею, выполните следующие действия.

1. Нажмите на защелку дверцы
батарейного отсека и откройте
дверцу.
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2. Нажмите на металлический выступ
фиксатора батареи вниз и по
направлению к задней стороне
прибора.

3. Поднимите вверх фиксатор батареи.

4. Поднимите батарею за выступ.

5. Вставьте батарею в любое из двух
гнезд, расположив ее так, как показано
на рисунке.

6. Закройте и защелкните металлический
фиксатор батареи и дверцу
батарейного отсека.

7. Чтобы извлечь батарею,
выполните шаги 1– 6 в обратной
последовательности.

Чтобы увеличить время эксплуатации, во второе гнездо можно установить еще одну батарею. Используйте только
батареи указанного типа. При покупке аккумуляторной батареи обратитесь в Центр обслуживания Tektronix, чтобы
уточнить ее правильный номер по каталогу.

ПРИМЕЧАНИЕ. Перед установкой или извлечением аккумуляторных батарей отсоедините от прибора кабели
источника питания.

Новые батареи или батареи, которые длительное время не использовались, перед установкой в прибор
необходимо зарядить. (См. стр. 4, Зарядка батарей.)

Подключение адаптера переменного тока

1. Поднимите ремешок прибора, чтобы
открыть разъем для адаптера
источника питания.

2. Подключите адаптер переменного
тока к прибору.
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3. Подключите адаптер переменного
тока к правильно заземленному
источнику переменного тока при
помощи прилагаемого шнура питания.

4. Зарядите батареи перед первым
использованием прибора на питании
от батареи. (См. стр. 4, Зарядка
батарей.)

Зарядка батарей
Зарядите батареи перед первым использованием прибора на питании от батареи. Батареи частично заряжены и
откалиброваны в заводских условиях. Откалиброванная батарея позволяет прибору точнее оценить, как долго могут
работать прикладные модули, прежде чем произойдет автоматическое отключение прибора. По завершении зарядки
находящийся на передней панели индикатор состояния заряда батарей (BATTERIES) выключается.

Информацию о калибровке батарей см. в разделе Калибровка батареи интерактивной справки по приложению
SA2500.

Примерное время зарядки 1

Количество батарей Питание прибора включено Питание прибора выключено

1 10 часов 5,5 часов

2 20 часов 11 часов

1 Время зарядки, типичное для батарей, которые разряжены сильно, но не полностью.

Управление электропитанием от батареи

Программа Power Management (Управление электропитанием) позволяет определять степень заряда
батареи, получать информацию о дате изготовления батареи, ее зарядной емкости и устанавливать режимы
энергосбережения с целью обеспечения максимальной продолжительности работы прибора.

Чтобы открыть программу Power Management (Управление электропитанием), выберите Start > Settings > Control
Panel (Пуск > Настройки > Панель управления), после чего дважды нажмите значок Power Management (Управление
электропитанием). Программу Power Management (Управление электропитанием) можно также открыть двойным
нажатием значка электропитания в области уведомления Windows CE. Значок электропитания представляет собой
изображение вилки электропитания или аккумуляторной батареи в зависимости от того, что является источником
электропитания прибора в данный момент.
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Обслуживание аккумуляторной батареи и обращение с ней
Литиево-ионные аккумуляторные батареи нуждаются в регулярном обслуживании и требуют бережного обращения.
Для получения сведений о характеристиках, замене, хранении, транспортировке, утилизации и повторном
использовании батареи, а также о мерах предосторожности при обращении с ней см. раздел интерактивной справки
Обслуживание аккумуляторной батареи.

Включение и выключение прибора, проверка его работоспособности

1. Чтобы включить прибор,
коснитесь кнопки On/Standby
(Включение/ожидание).

В строке состояния ОС WindowsCE
прибора отображается значок
батареи, если прибор в качестве
источника электропитания использует
батарею, или значок внешнего
источника электропитания, если
прибор получает питание от внешнего
адаптера.

Чтобы выключить прибор, снова
коснитесь кнопки On/Standby
(Включение/ожидание).

Информацию о режимах
электропитания прибора
(включение/ожидание) см. в
интерактивной справке: Start > Help >
Tektronix Basics > Shutting Down the
Instrument (Пуск > Справка > Основы
Tektronix > Выключение прибора).

2. Для проверки работоспособности
прибора посмотрите на экран.
Убедитесь, что прибор не показывает
никаких диагностических сообщений
об ошибках, связанных с его
включением.
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Калибровка сенсорного экрана
Перед первым использованием прибора откалибруйте дисплей с сенсорным экраном, чтобы он правильно
реагировал на прикосновения. Пользовательский интерфейс прибора базируется на технологии сенсорного экрана.
Выбор элементов управления и манипулирование ими производится при помощи касания виртуальных элементов
управления на экране прибора. Виртуальные элементы управления ведут себя точно также, как и физические.

1. Чтобы открыть экран панели
управления, выберите Start > Settings
> Control Panel (Пуск > Настройки >
Панель управления).

2. Дважды коснитесь значка Stylus
(Перо) на экране панели управления.

3. Чтобы настроить скорость касания, на
вкладке Double Tap (Двойное касание)
дважды коснитесь с удобной частотой
пером или пальцем сетки с шахматной
раскраской.

4. Дважды коснитесь контрольного
значка, чтобы проверить настройку.

5. Коснитесь вкладки Calibration
(Калибровка) и прочтите инструкции.

6. Коснитесь кнопки Recalibrate
(Перекалибровать), чтобы открыть
экран с указателем положения
курсора.

7. Следуйте инструкциям на экране
с указателем. Когда указатель
положения исчезнет, коснитесь экрана
в любом месте, чтобы вернуться на
вкладку Calibration (Калибровка).

8. Коснитесь кнопкиOK, чтобы сохранить
настройки калибровки.
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Установка даты и времени
При первом включении прибора необходимо установить дату, время и часовой пояс вашего местоположения.
Переустанавливать время нужно только в случае использования прибора в новом часовом поясе или в случае, если
для синхронизации часов не используется система GPS. При перемещении прибора в регион с другим часовым
поясом необходимо изменять настройку часового пояса. Дата и время системы всегда синхронизируются с датой и
временем системы GPS, а затем для установки местного времени используется настройка часового пояса.

1. Дважды коснитесь поля времени
на панели задач или выберите
Start > Settings > Control Panel >
Date/Time (Пуск > Настройки > Панель
управления > Дата и время).

2. Установите правильные дату, время и
часовой пояс в соответствии с вашим
местоположением.

3. Нажмите кнопку OK, чтобы принять
настройки и закрыть диалоговое окно.

Запуск приложения анализатора спектра SA2500
Приложение SA2500 запускается автоматически при первом включении прибора. Если приложение SA2500
автоматически не запускается или пользователь завершил его работу, для его запуска следует воспользоваться
одним из следующих методов.

Дважды коснитесь значка SA2500 на
экране прибора.

Выберите Start > Programs >
Tektronix Applications > SA2500 (Пуск
> Программы > Приложения Tektronix
> SA2500).

Приложение на приборе будет открыто.
На панели задач Microsoft WindowsCE
отображается кнопка для каждого
работающего приложения. Чтобы
вывести приложение на передний план
экрана, коснитесь кнопки SA2500 на
панели задач.
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Настройка цветов экрана
Цветовую схему, используемую дисплеем прибора, можно изменить. Цветовая схема оптимизирует цвета дисплея
применительно к различным условиям работы (в помещении или вне его) и для повышения качества печати на
черно-белых (монохромных) принтерах.

1. Выберите Setup > Color Preferences
(Настройка > Параметры цвета).

2. Коснитесь области списка Color
Scheme (Цветовая схема) и выберите
цветовую схему.

3. Коснитесь кнопки OK.

4. Чтобы закрыть приложение, выберите
File > Exit (Файл > Выход).

5. Перезапустите приложение, чтобы
активизировать измененную цветовую
схему.
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Ознакомление с прибором

Элементы прибора

1. Батарейный отсек.

2. Сигнальные разъемы. (См. стр. 10,
Сигнальные разъемы.)

3. Порты ввода-вывода. (См. стр. 10,
Разъемы входа/выхода.)

4. Порты карты PCMCIA.

5. Кнопка электропитания и панель
состояния. (См. стр. 9, Кнопка
включения/ожидания и панель
состояния.)

6. Разъем для внешнего адаптера
питания. (См. стр. 3, Подключение
адаптера переменного тока.)

7. Сенсорный экран.

Кнопка включения/ожидания и панель состояния

1. Кнопка On/Standby
(Включение/ожидание). Применяется
для включения и выключения
прибора. Дополнительные сведения
см. в интерактивной справке: Start >
Help > Tektronix Basics > Shutting
Down the Instrument (Пуск > Справка
> Основы Tektronix > Выключение
прибора).

2. Кнопка Reset (Сброс). Применяется для аппаратной перезагрузки. Все программы и данные, находящиеся в
энергозависимой памяти, стираются. Обычно используется только для восстановления после «зависания»
системы. Для нажатия на кнопку сброса воспользуйтесь тонким щупом.

3. Состояние электропитания/дисплея. Зеленый цвет указывает на то, что прибор включен. Желтый — сам прибор
включен, а дисплей выключен (для экономии электропитания).

4. Состояние заряда батареи. Зеленый цвет показывает, что прибор подключен к внешнему источнику питания и
заряжает установленные батареи. Красный цвет сообщает о низком заряде батареи. Если не горит ни один из
индикаторов, значит, батареи заряжены.
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Ознакомление с прибором

Разъемы входа/выхода

1. Вход микрофона

2. Разъем для наушников

3. Разъем для локальной сети Ethernet
(RJ-45)

4. Последовательный порт RS-232

5. Разъем для клавиатуры PS/2

6. Разъем USB Host

7. Разъем USB Slave

Сигнальные разъемы

1. IF OUT (ПЧ ВЫХ.). Преобразованный
с понижением сигнал промежуточной
частоты, который можно передать
для дальнейшего анализа на внешнее
тестовое оборудование, например
осциллограф. (См. стр. 28, Выходной
ПЧ-сигнал.)

2. GPS. Обеспечивает соединение с
антенной GPS.

3. TRIGGER/TIMING IN (ЗАПУСК/СИНХРОНИЗАЦИЯ ВХ.). Обеспечивает соединение с сигналом уровня ТТЛ для
включения прибора с помощью внешнего источника. (См. стр. 30, Синхронизация.)

4. FREQ REF IN (ОПОРНАЯ ЧАСТОТА ВХ.). Обеспечивает соединение с внешним источником сигнала опорной
частоты для повышения точности измерений. Дополнительные сведения см. в разделе интерактивной справки
Требования к входным сигналам.

5. RF IN (РЧ ВХ.). Обеспечивает подключение к прибору РЧ-антенны или источника входного сигнала.
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Ознакомление с прибором

Пользовательский интерфейс

1. Командная строка. (См. стр. 11,
Командная строка.)

2. Общие элементы управления
измерениями. (См. стр. 12, Общие
элементы управления измерениями.)

3. Элементы управления
изображением. (См. стр. 13,
Кнопки управления отображением.)

4. Измерительные панели. (См.
стр. 13, Кнопки панели измерений.)

5. Кнопки режимов измерений. (См.
стр. 15, Кнопки режимов измерений.)

6. Результаты измерений.
Отображаются осциллограммы,
результаты измерений и маркерные
показания. Вид данной области
изменяется в зависимости от
выбранного режима и типа измерения.

Командная строка

Содержит меню приложения, а также кнопки пуска/приостановки приложения и настройки параметров системы GPS,
опорного сигнала и внешнего усилителя/аттенюатора.

Элемент Описание

Меню. Информацию о функциях меню см. в разделе Меню интерактивной справки.

Кнопка Select Measurement Display (Выбрать тип отображения измерения).
Открывает диалоговое окно, в котором можно выбрать режим измерения прибора.
(См. стр. 18, Выбор типа измерения.)

Кнопка Run/Pause (Пуск/пауза). Запускает или приостанавливает текущий сбор
данных измерения.

Кнопка состояния GPS. Показывает состояние привязки сигнала GPS-приемника
(внутреннего или внешнего). Цвет указывает на состояние привязки сигнала
GPS-приемника. Коснитесь этой кнопки, чтобы открыть диалоговое окно GPS. Более
подробную информацию см. в разделе Диалоговое окно «GPS» интерактивной
справки.
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Ознакомление с прибором

Элемент Описание

Кнопка состояния опорной частоты измерения. Показывает источник опорной
частоты измерения. Коснитесь этой кнопки, чтобы открыть диалоговое окно Inputs
(Входные сигналы).

Доступными источниками опорной частоты измерения являются внутренний
генератор опорной частоты прибора (F INT), внешний генератор опорной частоты
(F EXT) и сигнал GPS (FGPS). Более подробную информацию см. в разделе
Диалоговое окно Inputs (Входные сигналы) интерактивной справки.

Кнопка состояния усиления/ослабления входного РЧ-сигнала. Указывает на
состояние внешнего аттенюатора или усилителя. Коснитесь этой кнопки, чтобы
открыть вкладку Inputs (Входные сигналы), где можно установить коэффициенты
усиления или ослабления входного сигнала. Используйте эту кнопку, если входной
сигнал подается на аттенюатор или усилитель. Более подробную информацию см.
в разделе Диалоговое окно Inputs (Входные сигналы) интерактивной справки.

Кнопка Help (Справка). Открывает интерактивную справку. Интерактивная
справка является контекстно-зависимой и всегда отображает тему, относящуюся
к текущему режиму измерений или экрану. Если текущий экран не является
контекстно-зависимым, прибор открывает главное меню интерактивной справки.
Чтобы найти конкретную информацию, используйте индекс или выполните поиск по
ключевому слову.

Общие элементы управления измерениями

Эти элементы управления устанавливают отображаемый опорный уровень (вручную или автоматически), диапазон
частот и измеряемую частоту.

Элемент Описание

Кнопка и поле Reference Level (Опорный уровень). Показывает опорный
уровень текущего входного РЧ-сигнала. Коснитесь кнопки Ref Level
(Опорный уровень), чтобы открыть клавиатуру и ввести конкретное
значение уровня. Коснитесь поля Ref Level (Опорный уровень), чтобы
открыть элемент управления для пошагового увеличения или уменьшения
текущего значения опорного уровня.

Кнопка AutoLevel (Автоуровень). Коснитесь кнопки для автоматического
определения максимального уровня входного сигнала по всему диапазону
частот прибора и установите соответствующий опорный уровень.
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Ознакомление с прибором

Элемент Описание

Элементы управления и поле Span (Диапазон). Показывает диапазон
частот отображаемого сигнала. Коснитесь кнопок со стрелками для
пошагового увеличения или уменьшения значения диапазона на принятые
по умолчанию интервалы (1, 2, 5). Коснитесь поля Span (Диапазон), чтобы
открыть клавиатуру и ввести конкретное значение диапазона.

Кнопка и поле Measurement Frequency (Измеряемая частота). Показывает
частоту измерения спектрального сигнала. Коснитесь кнопки Freq
(Частота), чтобы открыть клавиатуру и ввести конкретное значение
частоты. Коснитесь поля со значением частоты, чтобы открыть элемент
управления для пошагового увеличения или уменьшения текущего
значения опорного уровня.

Используйте вкладку Freq/Span (Частота/диапазон) (Spectrum drawer
> More (Спектральная панель > Дополнительно)), чтобы связать
измеряемую частоту с отображаемой центральной частотой или отменить
такую связку.

Кнопки панели измерений

Элемент Описание

Кнопки панели предоставляют дополнительные элементы управления для настройки
параметров. Показанный набор кнопок панели меняется в зависимости от выбранного
режима измерений. Кнопки панели всегда находятся на экране, обеспечивая быстрый доступ
к наиболее важным элементам управления для данного типа измерений или настроек.

Коснитесь кнопки панели, чтобы открыть эту панель. Стрелка, указывающая вниз, говорит о
том, что панель открыта.

Коснитесь кнопки More (Дополнительно), чтобы открыть вкладки параметров, при помощи
которых можно настроить дополнительные параметры измерений.

Коснитесь кнопки Help [?] (Справка), чтобы отобразить информацию о данной панели.

Кнопки управления отображением

Кнопки управления отображением позволяют выбирать тип отображения сигнала, перемещать область отображения
сигнала, включать и выключать маркеры.

Элемент Описание

Кнопка Spectrum (Спектр). Отображает измерение спектра. (См. стр. 19, Отображение спектрального
сигнала.)

При отображении спектра эта кнопка заменяется на кнопку DPX® Spectrum (Спектр DPX®).

Кнопка DPX Spectrum (Спектр DPX). Отображает измерение спектра DPX. (См. стр. 23, Отображение
сигнала спектра DPX.)

При отображении спектра DPX эта кнопка заменяется на кнопку Spectrum (Спектр).
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Ознакомление с прибором

Элемент Описание

Кнопка Front Trace (Передняя кривая). Позволяет выбрать, какая кривая должна отображаться на
переднем плане. Касайтесь этой кнопки для циклического выбора всех активных кривых. В поле Trace
(Кривая) на панели Spectrum (Спектр) отображается имя передней кривой и ее тип. Дополнительные
сведения см. в разделе интерактивной справки Вкладка Trace (Кривая).

Кнопка Zoom (Масштабирование). Позволяет масштабировать осциллограмму, изменяя диапазон.
Чтобы приблизить (увеличить) осциллограмму, коснитесь и проведите ней слева направо. Чтобы
отдалить (уменьшить) осциллограмму, коснитесь и проведите по ней справа налево. Функция
масштабирования для большинства осциллограмм работает только по горизонтальной оси (диапазон
частот).

Кнопка Cancel Zoom (Отменить масштабирование). При измерениях амплитуды сигнала в
зависимости от времени, если осциллограмма увеличена, эта кнопка отменяет масштабирование и
восстанавливает отображение всего массива собираемых данных.

Кнопка Move Waveform (Переместить осциллограмму). Позволяет перемещать отображение
осциллограммы. Выполните касание и перетаскивание на экране, чтобы переместить осциллограмму
в горизонтальном или вертикальном направлении (перемещение по диагонали невозможно).
Масштаб вертикального опорного уровня изменяется, отслеживая это движение. Если изображение
перемещается так, что измеряемая частота выходит за пределы экрана, прибор устанавливает в
качестве измеряемой частоты значение ближайшего края изображения.

Кнопка Pan Horizontal (Горизонтальное панорамирование). Позволяет перемещать изображение
осциллограммы в горизонтальном направлении. Если осциллограмма перемещается так, что
измеряемая частота выходит за пределы экрана, прибор устанавливает в качестве измеряемой
частоты значение ближайшего края изображения.

Кнопка Pan Vertical (Вертикальное панорамирование). Позволяет перемещать осциллограмму в
вертикальном направлении.

Кнопка Undo (Отменить). Отменяет последнее касание сенсорного экрана или перетаскивание
(например, при перемещении или масштабировании).

Кнопка Reset (Сброс). Стирает текущие данные сигнала и запускает новый цикл регистрации сигнала.

Кнопка Display Markers (Отображение маркеров). Отображает или скрывает значки и показания
маркеров. При скрытых маркерах скорость обновления изображения осциллограммы выше.
Дополнительные сведения см. в разделах интерактивной справки Маркеры и Вкладка Markers
(Маркеры).

Следующие кнопки показываются только в режиме классификации сигнала. Они заменяют собой кнопки управления
отображением спектра.

Для измерений с классификацией сигнала на приборе SA2500 должна быть установлена опция EP2.

Кнопка Edit Region (Редактировать зону). Включает режим редактирования зоны и заменяет
кнопки управления Spectrum Zoom (Масштабирование спектра) и Move Waveform (Переместить
осциллограмму) на кнопки Change Span (Изменить диапазон) и Move Region (Переместить зону)
соответственно. (См. стр. 35, Редактирование зоны классификации сигнала.)

Кнопка Change Span (Изменить диапазон). Позволяет изменять диапазон частот в зоне. Эту функцию
нельзя использовать применительно к декларированной (классифицированной) зоны. (См. стр. 35,
Редактирование зоны классификации сигнала.)

Кнопка Move Region (Переместить зону). Позволяет переместить зону на новый участок сигнала. Эту
функцию нельзя использовать применительно к декларированной (классифицированной) зоны. (См.
стр. 35, Редактирование зоны классификации сигнала.)
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Ознакомление с прибором

Кнопки режимов измерений

Кнопки режимов измерений используются для выбора типа выполняемых измерений или операций.

Элемент Описание

Кнопка Spectrum Measurement (Измерение спектра). Настраивает прибор на отображение измерений
спектра. (См. стр. 19, Отображение спектрального сигнала.)

Кнопка Spectrogram Measurements (Измерения спектрограммы). Настраивает прибор на отображение
измерений спектрограммы. (См. стр. 21, Отображение спектрограммы.)

Кнопка iMap. Включает в приборе нанесение результатов измерений на карту. Используется для
графической записи результатов измерений, позволяющей анализировать характеристики сигнала,
находить помехи и сохранять информацию, полученную при измерении и обнаружении. (См. стр. 39,
Режим привязки измерения к месту на карте iMap.)

Элементы управления вводом параметров

Коснитесь поля или кнопки параметра, чтобы открыть соответствующий элемент управления вводом параметра для
данного поля или кнопки.

Элемент Описание

Элемент управления Increment (Пошаговое изменение) позволяет использовать
кнопки для увеличения или уменьшения значения поля маленькими или большими
шагами. Кнопки с одиночными стрелками позволяют вносить небольшие изменения.
Кнопки с двойными стрелками позволяют вносить большие изменения.

Коснитесь кнопки Keypad (Клавиатура), чтобы открыть клавиатуру, при помощи
которой в выбранное поле вводится значение. Клавиатура изменяется и отображает
доступные функции ввода для выбранного элемента.

WindowsCE предоставляет возможность использовать панель ввода (виртуальную
клавиатуру), посредством которой можно вводить текст, например имена файлов. В
большинстве случаев, когда на приборе открывается диалоговое окно, содержащее
поля для ввода текста, открывается также и панель ввода. При закрытии
диалогового окна панель ввода также закрывается.

Чтобы открыть панель ввода вручную, коснитесь кнопки Input Panel (Панель ввода)

в ОС WindowsCE ( , самый правый значок на панели задач). Можно открыть
стандартную или расширенную клавиатуру. Коснитесь кнопки Input Panel (Панель
ввода) еще раз и выберите команду Hide Input Panel (Скрыть панель ввода), чтобы
закрыть клавиатуру.

Открыть панель ввода можно также путем выбора Tools > Keyboard (Сервис >
Клавиатура).
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Ознакомление с прибором

Получение справки
Приложение включает в себя обширную интерактивную справочную систему. Получить доступ к интерактивной
справке можно нижеперечисленными способами.

Элемент
интерактивной
справки Описание

Кнопка Help (Справка). Находится в верхней правой части экрана, а также на
большинстве измерительных панелей или вкладок. Коснитесь этой кнопки, чтобы
отобразить раздел справки, соответствующий текущим режиму отображения,
измерительной панели или содержимому вкладки.

Кнопка справки в диалоговом окне. Коснитесь этой кнопки, чтобы отобразить раздел
интерактивной справки, соответствующий данному диалоговому окну.
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Основы работы

Основы работы

Включение стандартов сигнала
Включите (выберите) стандарты сигнала, которые предполагается анализировать или измерять. Включенные
стандарты сигнала перечислены в различных полях прибора.

1. Выберите Setup > Signal Standards
(Настройка > Стандарты сигнала).

2. Коснитесь имени стандарта в
списке Signal Standards supported
(Поддерживаемые стандарты
сигнала), который требуется
включить. Перетащите перо, чтобы
выбрать несколько соседствующих
друг с другом стандартов.

3. Коснитесь кнопки Add >> (Добавить
>>), чтобы добавить выбранные
стандарты в список Signal Standards
selected (Выбранные стандарты
сигнала).

4. Коснитесь кнопки OK. Теперь
включенные стандарты можно
выбирать из любого раскрывающегося
списка стандартов.

Включение типов сигнала
Включите (выберите) типы сигнала, которые предполагается анализировать или измерять. Список включенных
типов сигнала отображается в различных полях прибора. Используйте включенные типы сигнала для настройки
параметров измерения, таких как измеряемая частота и полоса пропускания.

1. Выберите Setup > Signal Types
(Настройка > Типы сигнала).
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2. Коснитесь имени стандарта в
списке Signal Types supported
(Поддерживаемые типы сигнала),
который требуется включить.
Перетащите перо, чтобы выбрать
несколько соседствующих друг с
другом стандартов.

3. Коснитесь кнопки Add >> (Добавить
>>), чтобы добавить выбранные
стандарты в список Signal Types
selected (Выбранные типы сигнала).

4. Коснитесь кнопки OK. Теперь
включенные типы можно выбирать из
раскрывающихся списков с типами
сигнала.

Выбор типа измерения

1. Коснитесь кнопки Select Measurement
Display (Выбрать тип отображения
измерения).

2. Коснитесь элемента в поле Category
(Категория).

3. Дважды коснитесь элемента в
поле Measurement (Измерение),
чтобы открыть выбранный режим
отображения измерения.

Измерение спектра/спектрограммы
При измерении спектра отображается спектральный состав сигнала (мощность в зависимости от частоты). При
измерении спектра доступны следующие возможности.

Диапазон измеряемых частот от 10 кГц до 6,2 ГГц охватывает частоты большинства современных источников
сигналов.

Способность обнаружения сигналов очень низкого уровня.

До семи измерительных маркеров.

Маркеры интермодуляции для быстрой проверки этого общего источника необычных сигналов.

Прослеживание двух форм сигнала и пять режимов прослеживания.

Тесты по маске.
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Измерение спектрограммы отображает спектральный состав (мощность в зависимости от частоты) сигнала на
протяжении времени, где амплитуда сигнала представляется с использованием диапазона цветов. Этот режим
отображения особенно полезен при записи перемежающихся сигналов, поскольку он позволяет задать измерения с
разбивкой на части длиной от нескольких секунд до нескольких суток и автоматически сохранять эти измерения в
файле.

Отображение спектрального сигнала

1. Коснитесь кнопки режима Spectrum
(Спектр).

2. Коснитесь кнопки Freq (Частота) и
введите частоту измерения.

3. Коснитесь элементов управления
Span (Диапазон), чтобы изменить
отображаемый диапазон частот и
показать интересующую область
осциллограммы. Или коснитесь поля
Span (Диапазон) и измените значение
диапазона при помощи элементов
управления Increment (Пошаговое
изменение) или Keypad (Клавиатура).

4. Коснитесь кнопки AutoLevel
(Автоуровень), чтобы установить
опорный уровень отображения. Или
коснитесь кнопки Ref Level (Опорный
уровень) и введите соответствующее
значение с клавиатуры для введения
опорного уровня.
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Установка других параметров спектра

1. Используйте элементы управления
на панели Spectrum drawer (Панель
спектра) для задания разрешения
полосы пропускания, вертикального
масштаба отображения, действия
кнопки измеряемой частоты Marker-To
(Маркер в) и типа прослеживания
формы сигнала.

2. Коснитесь на панели спектра кнопки
More (Дополнительно), чтобы
отобразить вкладки параметров
спектра.

3. Коснитесь вкладки, чтобы отобразить
настраиваемые на ней параметры.

4. Чтобы отобразить интерактивную
справку для данной вкладки,
коснитесь на этой вкладке кнопки Help
(Справка) (знак вопроса).

5. Чтобы закрыть отображаемую вкладку
и вернуться в полноэкранный режим
работы прибора, коснитесь кнопки
Close (Закрыть) (X).
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Отображение спектрограммы

1. Выведите на экран представляющий
интерес сигнал спектра.

2. Коснитесь кнопки Measurement
Display (Отображение измерения) и
выберите тип измерения Spectrogram
(Спектрограмма).

3. Установите или снимите флажок Dual
Display (Двойное отображение) на
панели Spectrogram (Спектрограмма),
чтобы включить или выключить режим
одновременного отображения спектра
и спектрограммы на одном экране.

ПРИМЕЧАНИЕ. Если вкладки открыты,
чтобы их закрыть и отобразить
спектрограмму в нижней части экрана,
коснитесь на вкладке кнопки Close
(Закрыть) (X).

4. Чтобы отобразить вкладки параметров
спектрограммы, коснитесь кнопки
More (Дополнительно).

5. Чтобы вернуться в режим
отображения спектра, коснитесь
кнопки управления отображением
Spectrum (Спектр).

Информацию о других операциях со спектрограммой см. в разделе интерактивной справки, посвященном
спектрограмме.
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Просмотр записи спектрограммы

1. Вызовите изображение
спектрограммы.

2. Чтобы остановить сбор данных
измерения, коснитесь кнопки Stop
(Остановить).

3. Коснитесь поля Data Record (Запись
данных) на панели Spectrogram
(Спектрограмма), чтобы открыть
элемент управления Data Record
(Запись данных).

4. Касайтесь кнопок со стрелками для
перемещения курсора записи (белая
линия на графике спектрограммы)
к искомой записи. На панели
Spectrogram (Спектрограмма)
отображается информация о
времени и дате выбранной записи
непосредственно под полем Data
Record (Запись данных).

5. На графике спектра отображается
осциллограмма выбранной записи
(в режиме двойного отображения).

Информацию о просмотре
сохраненных записей спектрограмм
см. в разделе Просмотр сохраненных
файлов спектрограмм интерактивной
справки.
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Отображение спектра DPX®

Технология отображения спектра DPX использует оттенки цветов и послесвечение данных, чтобы показать, как
характеристики сигнала меняются во времени.

Цветовые оттенки показывают, насколько самосогласованной является форма кривой, для которой цвет
представляет собой интенсивность поступления спектральных компонентов сигнала. Система DPX Spectrum
Display работает, используя двумерный массив, представляющий собой точки данных на экране. Каждый раз,
когда на кривую, находящуюся на экране, ставится очередная точка, прибор увеличивает значение счетчика для
данной точки. Каждой точке на экране назначается цвет, исходя из значения соответствующего ей счетчика,
деленного на общее число отсчетов (процент событий). Таким образом, регистрируемые с течением времени
отсчеты формируют осциллограмму DPX, или точечный рисунок, использующий цвета, чтобы показать, как часто
происходила регистрация точки на дисплее.

Послесвечение определяет период времени, в течение которого точка остается видимой на экране, что может быть
полезно для отображения нечасто происходящих событий. Послесвечение экрана можно установить переменным
или бесконечным. В режиме переменного послесвечения период распада определяет интервал времени, в
течение которого точка остается видимой на экране. В режиме бесконечного послесвечения, будучи однажды
зарегистрированной на экране, точка остается видимой до тех пор, пока не будет запущено новое измерение.

Рабочие характеристики при отображении DPX

Как следует из приведенной ниже таблицы, рабочие характеристики прибора SA2500 без опции и с опцией EP1
различаются.

Рабочая характеристика SA2500 SA2500 с опцией EP1

Частота обработки спектра 2500 БФП (быстрое
преобразование Фурье)
в секунду

10 000 БФП (быстрое
преобразование Фурье) в
секунду

Минимальная длительность сигнала для
100-процентной вероятности перехвата

500 мкс 125 мкс

Отображение сигнала спектра DPX

1. Выведите на экран представляющий
интерес сигнал спектра. (См. стр. 19,
Отображение спектрального
сигнала.)

2. Коснитесь кнопки управления
отображением DPX Spectrum (Спектр
DPX).
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3. Коснитесь на панели спектра DPX
кнопки More (Дополнительно), чтобы
отобразить вкладки с параметрами
спектра DPX.

4. Коснитесь вкладки Bitmap (Точечный
рисунок).

5. Коснитесь поля Intensity
(Интенсивность) и установите
интенсивность, обеспечивающую
необходимое качество видимости
событий. Более высокий уровень
яркости позволяет отображать
точки данных, полученные в
результате единичных, коротких
событий, а также дает возможность
применять послесвечение для
этих событий. Это позволяет
увидеть эффект от элементов
управления послесвечением для
нечасто происходящих событий.
Интенсивность также влияет на цвета,
используемые при отображении
точечного рисунка.

6. Установите флажок Dot Persistence
(Послесвечение точки), чтобы
включить элементы управления
послесвечением на экране точечного
рисунка. Послесвечение точки задает
длительность отображения точки, если
она не заменяется новыми данными.

Параметр Variable (Переменное)
определяет длительность
отображения точки до момента
ее затухания.

Параметр Infinite (Бесконечное)
неопределенно долго оставляет
видимыми все точки, пока не будет
запущено новое измерение.
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7. Для установки цветовой схемы
точечного изображения кривой
используйте поле Color (Цвет).

8. При помощи полей Max (Макс.) и Min
(Мин.) установите цветовой диапазон
для процента событий в точках
данных. Точки данных, находящиеся
между максимальной и минимальной
настройками, отображаются при
помощи цветов в соответствии с
порядком цветов на изображенной
цветовой схеме.

Параметр Max (Макс.) задает
максимальный процент событий,
необходимый для отображения точки
данных при помощи самого верхнего
цвета цветовой схемы. По умолчанию
используется значение 100 %.

Например, если максимальное
значение установлено на 90 %, точки
данных, которые находятся на уровне
90 % и выше, отображаются цветом,
соответствующим максимуму (верху)
цветовой схемы.

Параметр Min (Мин.) задает
минимальный процент событий,
необходимый для отображения точки
данных при помощи самого нижнего
цвета цветовой схемы. По умолчанию
используется значение 0 %.

Например, если минимальное
значение установлено на 10 %, точка
данных должна фиксироваться,
по крайней мере, в течение 10 %
времени, чтобы отображаться на
точечном рисунке.
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Измерение временной зависимости амплитуды
Измерение временной зависимости амплитуды показывает изменение амплитуды РЧ-сигнала в течение некоего
интервала времени в пределах полосы пропускания зарегистрированных данных (в соответствии с установкой
элемента управления Span (Диапазон)). Это измерение дает результат, аналогичный результату измерения в
режиме временной развертки на ПЧ-спектральном анализаторе сигналов с качающейся частотой.

Отображаемый сигнал, похожий на сигнал осциллографа, позволяет определить тип сигнала. Например,
передающие устройства GSM (как базовые станции, так и мобильные устройства) передают пакетные сигналы
длительностью 576 мкс в один из восьми временных интервалов в течение промежутка времени 4,61 мс в
полосе пропускания шириной примерно 200 кГц. Если всплески осциллограммы и параметры синхронизации
удовлетворяют временным характеристикам стандарта GSM, значит, наиболее вероятно, этот сигнал и является
сигналом стандарта GSM.

Отображение измерения временной зависимости амплитуды

1. Выведите на экран представляющий
интерес сигнал спектра. (См. стр. 19,
Отображение спектрального
сигнала.)

2. Коснитесь кнопки Select Measurement
Display (Выбрать тип отображения
измерения) и выберите тип измерения
Amplitude vs. Time (Временная
зависимость амплитуды). (См.
стр. 18, Выбор типа измерения.)

3. Воспользуйтесь элементами
управления панели Time Domain
(Временной интервал) для установки
вертикального масштаба дисплея
(Vertical Scale), действий кнопки
Marker-To (Маркер в) и типа кривой
активного сигнала.
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4. Коснитесь на панели Time Domain
(Временной интервал) кнопки More
(Дополнительно), чтобы отобразить
вкладки параметров спектра.

5. Коснитесь вкладки, чтобы отобразить
настраиваемые на ней параметры.

6. Чтобы отобразить интерактивную
справку для данной вкладки,
коснитесь на этой вкладке кнопки Help
(Справка) (знак вопроса).

7. Чтобы закрыть отображаемую вкладку
и вернуться в полноэкранный режим
работы прибора, коснитесь кнопки
Close (Закрыть) (X).
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8. Для отображения представляющего
интерес участка осциллограммы
используйте кнопки Zoom
(Масштабирование) и Pan Display
(Панорамирование отображения).

9. Для измерения временной разницы
между точками осциллограммы
коснитесь кнопки Display Markers
(Показать маркеры).

Выходной ПЧ-сигнал
Прибор SA2500 может преобразовывать входной РЧ-сигнал в сигнал промежуточной частоты и направлять его на
разъем IF OUT (ПЧ ВЫХ.). После этого можно передать ПЧ-сигнал на другое тестовое оборудование, например
осциллограф или демодулятор, для дальнейшего анализа.

1. Выберите Setup > Outputs (Настройка
> Выходные сигналы).

2. Установите флажок Enable IF Output
(Включить выходной ПЧ-сигнал).

3. Коснитесь кнопки OK.

ПРИМЕЧАНИЕ. Включение выходного ПЧ-сигнала приводит к тому, что измерения, производимые
прибором, получаются некалиброванными. Пока включен выходной ПЧ-сигнал, на приборе отображается
соответствующее предупреждение и кнопка UNCAL (НЕКАЛИБРОВАН). Чтобы вернуть прибор в состояние,
когда производимые измерения получаются калиброванными, снимите флажок Enable IF Output (Включить
выходной ПЧ-сигнал) в диалоговом окне Outputs (Выходные сигналы).

Более подробную информацию см. в разделе Диалоговое окно Outputs (Выходные сигналы) интерактивной
справки, а также таблицу Обще рабочие характеристики раздела Технические характеристики. (См. таблицу 1
на странице 59.)
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Некоторые советы по использованию выходного ПЧ-сигнала

Выходной ПЧ-сигнал включается только тогда, когда выбран режим измерений спектра или временной
зависимости амплитуды. Выходной сигнал выключается при выборе других типов измерений, даже если он
выбран настройкой элемента управления (то есть, поставлен флажок). При возвращении в режим измерений
спектра или временной зависимости амплитуды выходной ПЧ-сигнал снова включается.

Выходной ПЧ-сигнал недоступен при проведении измерений спектра, которые требуют многократной
регистрации. Многократная регистрация производится тогда, когда диапазон частот превышает 20 МГц, а также
возможна при некоторых комбинациях устанавливаемого вручную разрешения по полосе пропускания (RBW).
Чтобы гарантировать наличие выходного ПЧ-сигнала, установите для диапазона измерений значение не более
20 МГц, а для разрешения по полосе пропускания — Auto (Авто).

Включение выходного ПЧ-сигнала приводит к тому, что измерения, производимые прибором, получаются
некалиброванными. Пока включен выходной ПЧ-сигнал, на приборе отображается соответствующее
предупреждение и кнопка UNCAL (НЕКАЛИБРОВАН). Чтобы вернуть прибор в состояние, когда производимые
измерения получаются калиброванными, снимите флажок Enable IF Output (Включить выходной ПЧ-сигнал) в
диалоговом окне Outputs (Выходные сигналы).

Номинальная частота выходного ПЧ-сигнала составляет 140 МГц. При включении выходного ПЧ-сигнала
прибор отображает точное значение его частоты. Это та самая частота, в которую преобразуется центральная
частота РЧ-сигнала.

Номинальное сопротивление разъема IF OUT (ПЧ ВЫХ.) составляет 50 Ом.
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Синхронизация
Имеется возможность установить ряд параметров синхронизации, включая источник синхронизации, время
синхронизации, тип сигнала, значение порога пропускания сигнала, а также задержку синхронизации и положение
точки синхронизации в записи результатов измерений.

1. Коснитесь кнопки More
(Дополнительно) панелей Spectrum
(Спектр) или Time Domain (Временной
интервал).

2. Коснитесь вкладки Trigger
(Синхронизация).

3. Коснитесь поля Source (Источник)
и выберите тип синхронизации.
Настройка External (Внешний)
требует наличия сигнала запуска
ТТЛ-уровня на разъеме Trigger/Timing
(Запуск/синхронизация).

Чтобы выключить синхронизацию,
выберите пункт Free Run (Без
синхронизации) из списка Source
(Источник).
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4. Установите параметры
синхронизации. Обратите внимание,
что параметр Position (Положение)
доступен только в режиме измерения
временной зависимости амплитуды.

5. Коснитесь кнопки Force Trigger
(Принудительный запуск), чтобы
запустить измерение сигнала
независимо от того, каковы пусковые
настройки.

6. Чтобы прибор выполнял
синхронизацию в определенное
время и/или в определенный
временной интервал, выберите
источник синхронизации Internal
Timebase (Внутренняя временная
развертка), коснитесь поля Trigger
Time (Время синхронизации) и с
помощью диалогового окна Configure
Internal Time Trigger (Настройка
внутренней синхронизации времени)
задайте параметры синхронизации
времени.

Советы по использованию синхронизации

После подготовки к запуску прибор непрерывно осуществляет сбор данных сигнала до возникновения события
синхронизации. Событие синхронизации определяет момент остановки сбора данных. Настройки синхронизации
Delay (Задержка) и Position (Положение) управляют положением записи измерения относительно события
синхронизации, позволяя регистрировать данные сигнала как до, так и после события синхронизации.

Режимы синхронизации взаимодействуют с режимом прогона спектра (вкладка Spectrum Run (Прогон спектра)).
Если для режима Run (Прогон) задан параметр Continuous (Непрерывный), прибор непрерывно подготавливает
запуск синхронизации и при повторном возникновении условий синхронизации снова осуществляет регистрацию
сигналов. Чтобы осуществить единственный измерительный цикл после возникновения события синхронизации,
установите для режима Run (Прогон) параметр Single (Единственный).

Если при синхронизации с внутренней временной разверткой выбран только режим Trigger Time (Время
синхронизации), установите для времени синхронизации время, значение которого превышает текущее
время. При достижении времени синхронизации прибор производит одно измерение, а затем переходит
в приостановленное состояние. Затем для значения времени синхронизации следует установить время,
превышающее текущее время, чтобы прибор мог произвести новое измерение.

Если при синхронизации с внутренней временной разверткой выбраны параметры Repeat Interval (Повтор
интервала) или Both (Оба), время синхронизации прибора зависит от того, как прибор интерпретирует время
синхронизации относительно ближайшей 24-часовой точки в диапазоне ±12 часов от текущего времени прибора.
Для получения дополнительных сведений об использовании синхронизации с внутренней временной разверткой
с параметрами Repeat Interval (Интервал повтора) или Both (Оба) см. раздел интерактивной справки Советы по
синхронизации спектра.
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Значок синхронизации, расположенный в верхней части масштабной сетки дисплея, отображается, когда
прибор находится в режиме измерения временной зависимости амплитуды (временной интервал). Значок
синхронизации указывает положение события синхронизации на осциллограмме для всех режимов
синхронизации, кроме режима Free Run (Без синхронизации).

При спектральных измерениях синхронизация по уровню ПЧ может происходить даже тогда, когда никакая часть
отображаемой осциллограммы не достигает заданного порогового уровня синхронизации. Это происходит,
поскольку обнаружение уровня синхронизации осуществляется по полной мощности сигнала в диапазоне полосы
пропускания, тогда как отображаемая осциллограмма спектра отражает мощность сигнала, разделенную на
интервалы RBW вдоль рассматриваемого диапазона. Для модулированных сигналов с полосой пропускания
шире настройки RBW уровень мощности спектра сигнала на любом интервале RBW ниже полной мощности
сигнала, обнаруживаемого системой синхронизации.

Определенные настройки или комбинации настроек могут отключать внешнюю синхронизацию. Если
синхронизация отключена, прибор в течение короткого промежутка времени отображает уведомление желтого
цвета с подсветкой и отключает элементы управления на вкладке Trigger (запуск). Элементы управления на
вкладке Trigger (Синхронизация) включаются при изменении настроек на такие настройки, которые допускают
синхронизацию. Ниже приведены наиболее типичные причины отключения синхронизации.

Установленная ширина диапазона превышает 20 МГц

Установка такой комбинации ширины диапазона и разрешения по полосе пропускания (RBW), которая для
проведения измерения требует многократной регистрации сигнала

Выбор режимов измерения DPX (DPX), Audio Demod (Звуковая демодуляция) или Signal Strength (Сила
сигнала) (включая режим Signal Classification Audio Demod (Звуковая демодуляция при классификации
сигнала))

Классификация сигнала
Классификация сигнала помогает определить различные параметры неопределенного сигнала. Классификация
сигнала обеспечивает следующие возможности.

Определять представляющие интерес области как зоны (центральная частота и диапазон частот), находящиеся
в любом месте сигнала. (См. стр. 33, Определение зоны классификации сигнала.)

Сравнивать полосу пропускания и частоту неизвестного сигнала с известными стандартными сигналами.

Приписывать зонам классификационные метки и примечания. (См. стр. 37, Декларация зоны (классификация).)

Сохранять все определенные зоны в файле профилей зон. (См. стр. 39, Сохранение и загрузка профилей зон.)

32 Руководство по эксплуатации SA2500



Основы работы

Определение зоны классификации сигнала

1. Коснитесь кнопки Signal
Classification (Классификация
сигнала).

2. Выведите на экран представляющий
интерес сигнал спектра.

3. Коснитесь кнопки Add (Добавить).

4. Коснитесь экрана и проведите
по нему пером в горизонтальном
направлении, чтобы выбрать
диапазон зоны. Прибор рисует
прямоугольник, определяющий
частотный диапазон зоны. Полностью
охватывать прямоугольником
амплитудную часть сигнала нет
необходимости.
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5. Коснитесь поля Region Span
(Диапазон зоны), чтобы ввести точное
значение частотного диапазона зоны.

6. Коснитесь кнопки More
(Дополнительно), чтобы
отобразить вкладки параметров
для дополнительной настройки зоны,
например, для указания типа сигнала.

ПРИМЕЧАНИЕ. Для измерений с классификацией сигнала на приборе SA2500 должна быть установлена
опция EP2.

ПРИМЕЧАНИЕ. Одну и ту же измеряемую частоту могут перекрывать не более двух зон. Если определить
новую зону, охватывающую диапазон частот, уже входящий в две другие зоны, на приборе отобразится
соответствующее предупреждение, и прямоугольник, определяющий диапазон зоны, будет обведен тонкой
красной линией. Чтобы удалить неправильно выбранную зону, коснитесь кнопки Delete (Удалить). Чтобы
изменить определение диапазона, воспользуйтесь кнопками Change Span (Изменить диапазон) или Move Region
(Переместить зону). Никакие иные действия с зонами будут невозможны до тех пор, пока не будет исправлено
некорректное определение зоны. (См. стр. 35, Редактирование зоны классификации сигнала.)

ПРИМЕЧАНИЕ. По мере увеличения количества зон производительность системы снижается. В частности,
снижается частота обновления развертки, и увеличивается время, необходимое для перехода между двумя
любыми зонами. Хорошее практическое правило говорит о том, что общее количество зон не должно
превышать 100. Создавайте и сохраняйте отдельные профили, каждый из которых содержит не более 100 зон.
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Редактирование зоны классификации сигнала

1. Коснитесь кнопки Edit Region
(Редактировать зону), чтобы
переключить кнопки Zoom
(Масштабировать) и Move
(Переместить) на кнопки Change
Region (Изменить зону) и Move
Region (Переместить зону). Эта
кнопка отображается только в режиме
Signal Classification (Классификация
сигнала).

2. Чтобы изменить ширину (диапазон
частот) зоны, коснитесь кнопки
Change Span (Изменить диапазон).

3. Коснитесь зоны, которую необходимо
изменить. Затем нажмите и
с нажимом проведите пером
внутри охватывающего зону
прямоугольника, чтобы изменить
диапазон зоны в направлении
движения пера. Движение от центра к
периферии прямоугольника приводит
к увеличению зоны, а движение от
края прямоугольнику к центру — к ее
уменьшению. Для более щадящего
касания и движения по экрану лучше
всего подходит перо.

Передвинуть можно
только недекларированную
(неклассифицированную) зону.

Руководство по эксплуатации SA2500 35



Основы работы

4. Можно также, коснувшись поля
Region Span (Диапазон зоны) на
панели Region (Зона), ввести для этой
зоны конкретный диапазон частот.

5. Чтобы переместить зону, коснитесь
кнопки Move Region (Переместить
зону).

6. Коснитесь зоны, которую необходимо
переместить. Затем нажмите и с
нажимом проведите пером в любом
месте внутри охватывающего зону
прямоугольника, чтобы переместить
зону в направлении движения пера.
Для более щадящего касания и
движения по экрану лучше всего
подходит перо.

Передвинуть можно
только недекларированную
(неклассифицированную) зону.

7. Коснитесь кнопки Add (Добавить)
панели Region (Зона), чтобы
определить новую зону на кривой
сигнала.

8. Коснитесь кнопки Delete (Удалить)
панели Region (Зона), чтобы удалить
текущую выделенную зону.

9. Коснитесь кнопки Delete All (Удалить
все) панели Region (Зона), чтобы
удалить все определенные для
сигнала зоны.
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10. Коснитесь кнопок со стрелками
Previous Region (Предыдущая зона)
или Next Region (Следующая
зона), чтобы отобразить и
выбрать предыдущую или
следующую определенную зону
сигнала. Порядковый номер
зоны определяется измеряемой
частотой зоны (слева направо по
осциллограмме), но не порядком,
в котором она была создана. Если
зона находится за пределами экрана,
прибор выводит ее изображение на
экран.

Верхнее число соответствует номеру
текущей зоны, нижнее — общему
числу зон. Перечисление зон идет от
зон с меньшей частотой (левый край
сигнала) к зонам с большей частотой.
По мере добавления или удаления
зон, присвоенный конкретной зоне
номер может изменяться.

Декларация зоны (классификация)

Декларация зоны позволяет присвоить зоне классификационную категорию и сопроводить ее дополнительными
примечаниями о ней самой или о сигнале.

1. Выберите или определите зону.

2. Коснитесь кнопки Declare
(Декларировать), чтобы открыть
диалоговое окно Declare Region
(Декларировать зону).

3. Коснитесь списка Classification
(Классификация) и выберите
подходящую классификацию. С
назначением типа классификации
окну зоны также назначается
определенный цвет, позволяющий
быстро идентифицировать
классификацию декларированной
зоны.
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4. Коснитесь поля Description
(Описание), чтобы ввести краткое
описание длиной не более 14
символов. По умолчанию значению
этого поля присвоен тип сигнала,
установленный на вкладке Region
(Зона), но при желании его можно
изменить. Для ввода символов
используйте экранную клавиатуру
панели ввода WindowsCE или
клавиатуру, подсоединенную через
порт PS/2 прибора. (См. стр. 15,
Элементы управления вводом
параметров.)

5. Коснитесь поля Comments/Notes
(Комментарии/примечания) и введите
описательные детали. Допускается
вводить не более 255 символов.

6. Коснитесь кнопки OK, чтобы закрыть
диалоговое окно и завершить
декларацию зоны.

ПРИМЕЧАНИЕ. Если зона классифицирована, то чтобы внести в ее декларацию какие-либо изменения,
необходимо реклассифицировать ее в состояние None (Нет). Чтобы изменить классификацию зоны,
используйте кнопку Declare (Декларировать) или поле Classification (Классификация) панели Region (Зона).

Сводка профилей

Список Survey Summary (Сводка профилей) содержит все определенные (декларированные или недекларированные)
зоны и позволяет быстро выбрать и отобразить конкретные зоны.

1. Коснитесь кнопки More
(Дополнительно) на панели Region
(Зона), чтобы открыть ее вкладки для
настроек.

2. Коснитесь вкладки Survey Summary
(Сводка профилей).
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3. Коснитесь элемента списка, чтобы
выделить и отобразить эту зону.

4. Коснитесь любого заголовка столбца,
чтобы отсортировать элементы
списка по возрастанию значений,
содержащихся в данном столбце.

Сохранение и загрузка профилей зон

Профиль зоны представляет собой набор всех определенных зон текущего сигнала, перечисленных во вкладке
Survey Summary (Сводка профилей). Профили зон можно сохранять в файле, а затем загружать из него профиль
зоны для объединения с текущими определениями зон или их замены.

File > Save Survey (Файл > Сохранить профиль): сохраняет все определенные зоны в файле, имя и
расположение которого устанавливаются системой по умолчанию. Эта функция сохраняет только определения
зон.

File > Save Survey As (Файл > Сохранить профиль как): сохраняет все определенные зоны в файле, имя и
расположение которого устанавливаются пользователем. Эта функция сохраняет только определения зон.

File > Load Survey (Файл > Загрузить профиль): загружает профиль зоны из файла. Чтобы заменить текущие
определения зон на определения, содержащиеся в файле, или объединить их, следуйте инструкциям,
появляющимся на экране.

File > Load Survey from Results (Файл > Загрузить профиль из результатов): загружает определения зон,
являющиеся частью сохраненного файла результатов классификации сигнала (File > Save Results (Файл >
Сохранить результаты)). Чтобы заменить текущие определения зон на определения, содержащиеся в файле,
или объединить их, следуйте инструкциям, появляющимся на экране.

File > Export Regions As (Файл > Экспортировать зоны как): запись текущих определений зон в текстовый файл
со значениями, разделенными табуляцией или запятыми. Для получения сведений о структуре текстовых
файлов зон см. раздел интерактивной справки Формат файлов для импорта и экспорта зон.

File > Import Regions (Файл > Импортировать зоны): загрузка определений зон из файла со значениями,
разделенными табуляцией или запятыми. Если в приборе уже есть зоны с определениями, откроется диалоговое
окно Load Survey (Загрузка профиля). С помощью этого диалогового окна можно либо попытаться объединить
сохраненные зоны с существующими, либо удалить все существующие зоны и импортировать новые.

Режим привязки измерения к месту на карте iMap
Режим iMap включает в себя проецирование на карту помех и покрытия, как в помещении, так и на открытом
воздухе, и обеспечивает интегральное решение в полевых условиях проблем, связанных с помехами и покрытием,
в одном приборе.

Режим iMap прост в использовании: достаточно выбрать тип измерения и прикоснуться к тому месту на
отображаемой карте, где это измерение должно быть выполнено. Значки измерений снабжены цветовой кодировкой,
показывающей, прошли или нет измерения предельные тесты. К измерению можно также добавить стрелку азимута,
отражающую ориентацию антенны во время измерения.
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Для запуска режима iMap коснитесь
кнопки iMap. При первом запуске режима
iMap на экране появляется сообщение
Empty map (Пустая карта). В противном
случае iMap отображает последнюю
загружавшуюся карту.

Имеется возможность загружать отсканированные файлы точечной графики для использования в качестве карт
внутри помещений, или файлы форматов GSF и MIF для использования вне помещений. Наличие файлов формата
GSF или MIF позволяет использовать встроенный приемник GPS для автоматической привязки измерений к текущим
координатам.

Карты и ассоциированные с ними результаты измерений можно сохранять в файлах обычного формата типа
CSV или MapInfo. Сохранение карт и результатов измерений позволяет анализировать измеренные данные
(местоположение, значение и направление) и подготавливать отчеты.

Концепции файлов карт

Инструмент iMap использует два типа карт: карты с координатной сеткой и графические карты.

Карты с координатной сеткой. В файл карты с координатной сеткой внедрена привязка к геофизическим
широте и долготе. Прибор использует карты с координатной сеткой и активный приемник GPS для фиксации
на карте места проведения измерений, используя для этого текущие геофизические координаты. Для создания
карт с координатной сеткой требуется специальное компьютерное программное обеспечение. Их также можно
приобретать в компаниях, занимающихся изготовлением карт. Прибор может загружать файлы карт с координатной
сеткой как GSF-, так и MIF-форматов. Перед загрузкой карт программой iMap необходимо преобразовать карты,
не находящиеся в формате GSF, или карты формата MIF в формат GSF.

Карты с координатной сеткой требуют, чтобы активный приемник GPS осуществлял корректную привязку места
проведения измерений к геофизическим координатам карты. Активный приемник GPS — это приемник, который
принимает не менее четырех спутниковых сигналов и обеспечивает прибор точными данными GPS о его
местоположении. Если загружена карта с координатной сеткой, а приемник GPS либо не связывается со спутниками,
либо качество связи является недостаточным, прибор рассматривает карту с координатной сеткой, как графическую
карту.

Графические карты. В файлах графических карт привязка к геофизическим широте и долготе отсутствует.
Графические карты представляют собой графическое изображение, например, в виде отсканированного плана
этажа здания или объекта аэрофотосъемки, с которыми можно связывать место проведения измерения путем
прикосновения к определенной точке экрана.

Преобразование файлов в карты. Программу iMap Converter можно загрузить с веб-сайта компании Tektronix.
Она позволяет преобразовывать и сохранять графические файлы форматов BMP, JPEG, GIF, TIFF или PNG в
графические файлы карт формата GSF, преобразовывать графические карты в карты с координатной сеткой
и создавать карты с координатной сеткой при помощи таких приложений, как Microsoft MapPoint. (См. стр. 49,
Программа iMap Converter.)
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Загрузка карты

Чтобы воспользоваться программой iMap, необходимо сначала загрузить карту. Если карта уже была загружена во
время предыдущего сеанса, она остается загруженной до тех пор, пока не будет загружен файл новой карты.

1. После открытия iMap выберите
пункты меню File > Load Map (Файл >
Загрузить карту).

2. Выберите файл карты, который
следует загрузить (форматы
BMP, GSF, MIF или ZIP (карты с
результатами измерений)).

3. Коснитесь кнопки OK. Приложение
iMap загружает карту на экран.

Привязка измерения к месту на карте

Следующая процедура требует, чтобы измерение уже было установлено. Также уже должен быть загружен файл
карты. (См. стр. 41, Загрузка карты.)

1. Коснитесь кнопки Single Measurement
(единичное измерение).

2. Коснитесь кнопки измерений iMap.
Доступные типы измерений зависят
от стандарта текущего сигнала.
Выбранное измерение отображается
в области пиктограмм измерений.

3. Коснитесь карты.

Если приемник GPS активен,
и используется карта с
координатной сеткой, единичное
измерение привязывается к
текущим координатам GPS.

Если приемник GPS не
активен, или если используется
графическая карта (например,
план этажа здания), единичное
измерение привязывается к
месту, обозначаемому на карте
прикосновением.
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4. Можно также выбрать кнопку,
отвечающую за проведение другого
измерения, после чего, коснувшись
карты, добавить на нее новое
измерение. Значки нескольких
измерений, проведенных в одном и
том же месте, располагаются стопкой
один над другим.

5. Для перемещения значка коснитесь
кнопки Select (Выбрать), затем
коснитесь значка и перетащите его
в новое место. Если измерение
находится в стопке, состоящей из
нескольких измерений (например,
созданных в результате регистрации
большого количества данных), iMap
перемещает значок, находящийся
на самом верху стопки. Если значок
перемещается в новую стопку значков
измерений, порядок его размещения
определяется временем проведения
измерения.

ПРИМЕЧАНИЕ. На карте можно разместить не более 200 результатов измерений. По достижении данного
ограничения реакция iMap зависит от того, какой режим измерения активен. В режиме единичного измерения
iMap отображает сообщение о достижении ограничения и отменяет все последующие измерения. Выберите
File > Save Map With Results As (Файл > Сохранить карту с результатами как) для сохранения карты и
измерений в файл или File > Clear All Measurements (Файл > Очистить все измерения) для очистки карты и
продолжения нанесения измерений на карту.

В режиме измерений с регистрацией iMap отображает сообщение о достижении ограничения и сохранении
файлов, автоматически сохраняет карту и измерения в файл в текущем расположении для сохранения по
умолчанию, очищает карту, а затем продолжает наносить измерения на карту.

ПРИМЕЧАНИЕ. Чтобы добавить измерения в новое место карты с координатной сеткой при активном
приемнике GPS, необходимо физически переместиться на это место.
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ПРИМЕЧАНИЕ. Перемещать значки измерений на графической карте или на карте с координатной сеткой
можно только при неработающем приемнике GPS. Попытка переместить значок на карте с координатной
сеткой при активном приемнике GPS приводит к тому, что iMap перетаскивает карту вместе со значками
измерений на новое место на экране; при этом значки измерений относительно карты не перемещаются.

Если приемник GPS неактивен, переместить можно любой значок измерений. Это касается и перемещения
значков измерений, которые были поставлены на карту в режиме GPS. При включении приемника GPS программа
iMap не возвращает в исходное положение на карте значки тех измерений, которые были поставлены ранее при
работающем приемнике GPS.

Значки измерений iMap

Для обозначения измерений, выполненных в конкретном месте, приложение iMap использует систему значков.
Существуют два типа значков измерений: большой и флажок. На большом значке отображается тип измерения,
которое он представляет. Значок в виде флажка имеет маленькие размеры и используется только в режиме
измерений с регистрацией большого количества данных для указания мест, где эти измерения проводились. Более
подробную информацию см. в разделе Типы значков iMap для нанесения на карту мест проведения измерений
интерактивной справки.

Над значками измерений можно выполнять различные действия, включая просмотр обозначаемых значком
результатов измерений, перемещение и удаление значка, а также прикрепление к нему стрелки, указывающей
направление проведения измерений. Более подробную информацию см. в следующих разделах, а также в разделе
Просмотр нанесенных на карту измерений интерактивной справки.

Просмотр и удаление результатов измерений, помеченных значками

Чтобы просмотреть или удалить результаты измерений, помеченные значками измерений iMap:

1. Коснитесь кнопки режима Select
(Выбрать) программы iMap.

2. Коснитесь значка измерения, чтобы
открыть диалоговое окно Map
Measurements (Нанесение измерений
на карту).

3. Коснитесь в списке интересующего
измерения.

4. Коснитесь кнопки Open Measurement
(Открыть измерение), чтобы открыть
экран с данными выбранного
измерения. Коснитесь кнопки iMap,
чтобы вернуть экран iMap.

5. Коснитесь кнопки Delete Measurement
(Удалить измерение), чтобы
удалить выбранное измерение.
Если требуется удалить несколько
измерений, продолжайте выбирать и
нажимать кнопку Delete (Удалить).
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6. Чтобы переместить выбранное
измерение в начало списка,
коснитесь кнопки Measurement
to Top (Переместить измерение
наверх).

7. Коснитесь кнопки OK, чтобы закрыть
диалоговое окно.

ПРИМЕЧАНИЕ. Чтобы открыть окно с результатами измерения, достаточно также дважды коснуться
значка измерения. Если в одном месте проводилось несколько измерений, двойное касание значка приведет к
отображению результатов того измерения, значок которого находится наверху списка.

Чтобы удалить с карты значки всех измерений, выберите пункты меню File > Clear All Measurements (Файл >
Удалить все измерения).

Изображение стрелки, указывающей азимут (направление) измерения

Функция изображения азимута iMap позволяет с помощью стрелки на нанесенном на карту измерении указать
направление, в котором была обращена антенна при выполнении измерения.

1. Коснитесь кнопки Measurement
Direction (Направление измерения).

2. Коснитесь и перетащите центр
значка измерения в том направлении,
куда при выполнении измерения
была повернута антенна. iMap
изобразит стрелку, соответственно
направленную от значка измерения.
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В области миниатюр измерений
iMap отображается направление
стрелки. Отображаемая информация
зависит от типа карты (с координатной
сеткой или графическая). В примере
представлена карта с координатной
сеткой. Показания на миниатюре
помогут установить направление
стрелки измерения.

3. Чтобы изменить направление стрелки,
проведите новую линию. iMap заменит
существующую стрелку на стрелку
другого направления.

Удаление стрелки измерения азимута.

1. Коснитесь кнопки режима Select
(Выбрать) программы iMap.

2. Коснитесь один раз значка измерения
со стрелкой направления, которую
требуется удалить. В iMap откроется
диалоговое окно Map Measurements
(Измерения на карте).

3. Коснитесь названия измерения с
указательной стрелкой, которую
требуется удалить.

4. Коснитесь кнопки Delete Azimuth
(Удалить стрелку).

5. Коснитесь кнопки OK. iMap закроет
диалоговое окно и удалит стрелку
направления.

Регистрация измерений iMap (автоматические измерения)

Измерения с регистрацией большого количества данных позволяют автоматически привязывать к месту на карте,
если они единичные и выполняются в рамках установленного интервала времени, или изменять местоположение,
определяемое системой GPS (при наличии активного приемника GPS и карты с координатной сеткой).
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ПРИМЕЧАНИЕ. Программа iMap наносит на карту только результаты завершенных измерений. Если заданный
временной интервал оказывается меньше, чем требуется для проведения измерения, iMap игнорирует его и
продолжает наносить на карту получаемые результаты до тех пор, пока не закончится сбор данных. Например,
если для проведения измерения прибору требуется 20 секунд, а установленный временной интервал равен 10
секундам, прибор выполняет измерение и привязывает их к карте в течение всех 20 секунд.

1. Установите параметры измерения
(частоту, полосу пропускания и
т. д.), после чего коснитесь кнопки,
отвечающей за требуемый тип
измерения.

46 Руководство по эксплуатации SA2500



Основы работы

2. Коснитесь кнопки Log Measurements
(Измерения с записью массива
данных).

3. Выберите кнопку в области Measure
By (Измерить в зависимости от),
чтобы установить тип интервала
измерения (временной интервал
или расстояние между точками
проведения измерений). Выбор
расстояния возможен только тогда,
когда приемник GPS активен и точно
определяет местоположение.

4. Коснитесь поля в области Measure
Every (Интервал измерения), чтобы
установить интервал измерений.

5. Коснитесь карты, чтобы запустить
измерения массива данных.

Для карт с координатной сеткой
и при работающем приемнике
GPS коснитесь карты в любой
точке. Прибор добавляет флажки
измерений на карту в том
месте, которое в этот момент
определяется системой GPS.

При использовании графических
карт, или если используются
карты с координатной сеткой,
но приемник GPS не активен,
коснитесь карты в месте начала
измерения. Прибор начинает
выполнять измерения, но
не отображает их на карте,
пока измерение и регистрация
большого количества данных не
завершатся.
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6. Коснитесь карты, чтобы остановить
измерения.

Для карт с координатной сеткой и
при работающем приемнике GPS
коснитесь карты в любой точке.
Прибор прекратит связывать
результаты измерений с
координатами на карте.

При использовании графических
карт, или если используются
карты с координатной сеткой,
но приемник GPS не активен,
коснитесь карты в месте
последнего измерения.
Измерения будут равномерно
распределены на прямой линии,
соединяющей начальную и
конечную точки на карте.

7. Коснитесь кнопки Single Measurement
(Единичное измерение) или Select
(Выбрать), чтобы выйти из режима
измерений с регистрацией iMap.

ПРИМЕЧАНИЕ. На карте можно разместить не более 200 результатов измерений. Для карт с координатной
сеткой и при работающем приемнике GPS, если прибор достигает предела измерений, находясь в режиме
множественного измерения, кратковременно отображается сообщение, а измерения и карта автоматически
сохраняются в текущую папку сохранения результатов, затем карта очищается, и iMap продолжает наносить
на нее результаты измерений.

При использовании графической карты или карты с координатной сеткой без включенного сигнала GPS, если
прибор достигает предела в 200 результатов измерений, отображается сообщение с просьбой коснуться
позиции последнего измерения. Затем прибор автоматически сохраняет измерения на карте в файл и очищает
карту. Если прибор находится в режиме повторного измерения, новые измерения не начинаются, пока
пользователь не коснется новой начальной позиции на графической карте.
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ПРИМЕЧАНИЕ. Функция измерения и регистрации большого количества данных iMap во время сбора данных
автоматически устанавливает режим просмотра нанесенных на карту измерений на Measurement Flags
(Флажки измерения). По завершении программой iMap измерения и регистрации массива данных прибор
возвращается из режима просмотра нанесенных на карту измерений к тому режиму, в котором он находился
перед запуском этих измерений.

Если коснуться кнопки Select (Выбрать), Measurement Direction (Направление измерения) или Single
Measurement (Единичное измерение) во время измерения и регистрации массива данных в режиме, когда
система GPS отключена, iMap выходит из данного режима измерений и не наносит на карту никаких значков,
связанных с измерениями.

Карты с координатной сеткой при активном приемнике GPS поддерживают измерения и регистрацию большого
количества данных с заданным временным или пространственным интервалом. Графические карты или карты
с координатной сеткой при неактивном приемнике GPS поддерживают измерения и регистрацию большого
количества данных с заданным временным интервалом.

Значок измерения нельзя поместить на часть карты, закрытую «шапкой».

ПРИМЕЧАНИЕ. Когда прибор находится в режиме измерений с регистрацией (Setup > Logging (Настройка >
Регистрация)), измерения iMap (единичные или повторные) не наносятся на карту в виде значков измерения
iMap. Вместо этого, в месте измерения отображается значок X. Результаты измерения сохраняются
непосредственно в файл журнала и не связываются с файлом карты. Значок регистрации X не является
интерактивным. При его выборе не открывается список измерений, и значок нельзя переместить. Значок X не
влияет на ограничение в 200 результатов измерений.

Программа iMap Converter

Компания Tektronix предлагает программу преобразования файлов карт iMap Converter, которую можно загрузить с
веб-сайта компании. Программа iMap Converter позволяет преобразовывать графические файлы или файлы карт
для использования в программе iMap прибора. Ниже перечислены типы изображений или файлов, доступные
для преобразования.

Графические изображения в форматах BMP, JPEG, GIF, TIFF и PNG (изображения карт, планы этажей зданий,
аэрофотосъемка)

Соответствующие промышленному стандарту геофизические координатные сетки MapInfo Interchange Format
(MIF), ArcInfo Shape (.shp), USGS Digital Line Graph (.opt)

К другим особенностям программы iMap Converter относятся следующие.

Простой захват изображений из таких приложений, как Microsoft MapPoint, с целью создания геофизических
(координатных) файлов карт, используемых при привязке измерений к карте с помощью системы GPS.

Ручное назначение геофизических координат (широта/долгота) графическим файлам, таким как планы этажей
зданий, или захват изображений карт с экрана с целью создания карт с координатной сеткой для нанесения на
карту измерений с применением системы GPS-навигации.

Объединение нескольких координатных файлов растрового изображения в один большой файл.
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Установка программы iMap Converter на ПК

1. Посетите веб-узел корпорации Tektronix (www.tektronix.com).

2. Щелкните Software Downloads (Загрузка программ) в левой части экрана, чтобы открыть веб-страницу,
посвященную загрузке программ.

3. Введите imapconverter (одним словом) в поле Search by keyword (Поиск по ключевому слову), затем щелкните
кнопку Go (Перейти).

4. Нажмите на ссылку iMap Converter, чтобы загрузить программу. Следуйте инструкциям по установке,
приведенным на странице, с которой производится загрузка.

5. Чтобы открыть программу iMap Converter на ПК, выберите пункты меню Start > Programs > Tektronix >
iMapConverter (Пуск > Программы > Tektronix > iMapConverter).

6. Чтобы узнать, как пользоваться данным инструментом для преобразования файлов, для добавления координат
в графический файл или для создания карт, нажмите кнопку Help (Справка) программы iMap Converter.

ПРИМЕЧАНИЕ. Файлы растровой графики, которые преобразуются в GSF-формат, загружаются в прибор
быстрее, поскольку прибор не должен выполнять это преобразование сам. Однако при этом существует
вероятность перепутать файлы графического изображения GSF с сеточными (координатными) файлами GSF.
Используйте договоренность о присвоении имен файлам, чтобы различать GSF-карты, созданные из карт с
координатной сеткой, и GSF-карты, созданные из файлов растровой графики, не содержащих координатной
информации.

ПРИМЕЧАНИЕ. Файлы формата MIF загружаются значительно дольше файлов формата GSF. Компания
Tektronix рекомендует использовать iMap Converter для преобразования файлов карт из формата MIF в формат
GSF, а не загружать MIF-файлы в прибор напрямую.

Регистрация данных измерений
Регистрация данных измерений обеспечивает автоматическое сохранение результатов измерений и координат GPS
в отдельный файл или по сетевому UDP-адресу. Результаты измерений можно сохранять в файлы журнала одного
из типов или обоих типов одновременно (текстовый файл или сетевой адрес).

Файл журнала с координатами GPS содержит записи о времени (с корректировкой по часовому поясу), широте,
долготе и высоте над уровнем моря. Координаты GPS регистрируются ежесекундно (на основе времени системы
GPS, а не времени UTC). Данные о местоположении GPS не зависят от каких-либо данных о позициях измерений.

Файл журнала с результатами измерений содержит настройки измерений, отметку времени, значения координат
GPS, а также результаты измерений по каждой регистрации измерения. Каждое новое измерение добавляется
в конец файла журнала.
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1. Выберите Setup > Logging
(Настройка > Регистрация), чтобы
открыть диалоговое окно Logging
(Регистрация).

2. Перейдите на вкладку Measurement
Results (Результаты измерений) и
выберите объект для регистрации
(файл или UDP-адрес). Укажите
необходимые параметры.

3. Для результатов измерения можно
также указать формат вывода —
двоичный или CSV (разделенные
запятыми значения). Двоичный
формат более эффективен, чем
формат CSV, но приложения в
таком случае должны осуществлять
преобразование.

4. Чтобы включить регистрацию
координат GPS, перейдите на вкладку
GPS Position (Координаты GPS) и
выберите объект для регистрации
(файл или UDP-адрес). Укажите
необходимые параметры.

5. Коснитесь кнопки OK, чтобы закрыть
диалоговое окно и начать регистрацию
измерений.

6. Нажмите кнопку Help (Справка) для
получения дополнительных сведений
о функции регистрации, двоичном
формате файла и использовании
UDP-адресов для регистрации.
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7. Чтобы остановить регистрацию
данных измерений, коснитесь
элемента управления Disable Log
(Отключить регистрацию) на обеих
вкладках.

Режим регистрации продолжает работать при изменении измерений. При выборе нового измерения прибор
завершает регистрацию предыдущего типа измерения, переходит на новое измерение и продолжает регистрацию
нового измерения в том же файле журнала. Эта функция позволяет записывать результаты нескольких различных
измерений в один файл.

Для получения сведений о структуре двоичных файлов обратитесь в сервисную службу Tektronix.
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Удаленный доступ к прибору

Удаленный доступ к прибору позволяет выполнять следующие действия.

Удаленно управлять прибором с персонального компьютера (непосредственно или через сеть)

Передавать файлы данных, результатов измерений, настроек, карт и прочие файлы на прибор и получать
их с прибора

Распечатывать данные измерений и моментальные снимки экрана на сетевом принтере

Двумя методами удаленного доступа являются соединения Ethernet и ActiveSync. Соединение Ethernet является
гораздо более быстрым, чем ActiveSync, однако ActiveSync лучше подходит для организации обмена файлами
между прибором и ПК. Для конфигурирования каждого из методов доступа требуются уникальные действия, которые
описываются в последующих разделах.

Настройка сетевых параметров прибора
1. Выясните у своего сетевого администратора IP-адрес прибора SA2500. Если в сети используется протокол

DHCP, прибор при включении питания и подсоединении к сети должен автоматически получить IP-адрес. Если
сеть не поддерживает протокол DHCP, или прибору необходим фиксированный IP-адрес, обратитесь за этим
адресом к своему системному администратору.

2. Соедините прибор с сетевым разъемом при помощи стандартного кабеля локальной сети Ethernet. Это можно
сделать как до, так и после включения электропитания прибора.

3. На приборе коснитесь пунктов меню Start > Settings > Network and Dial-up Connections (Пуск > Настройки >
Сетевое подключение и подключение удаленного доступа). Сетевой интерфейс прибора регистрируется под
именем ENDS4ISA1.

4. Дважды коснитесь значка ENDS4ISA1, чтобы открыть диалоговое окно CSA8900 Settings (Настройки CSA8900).

Если прибор использует протокол DHCP для получения IP-адреса, и кнопка Obtain an IP address via DHCP
(Получить IP-адрес от сервера DHCP) включена, необходимость дальнейшего конфигурирования сети
отпадает. Закройте диалоговое окно.

Если прибору уже присвоен фиксированный IP-адрес, поля адреса должны отображать информацию об
адресе. При назначении или изменении фиксированного IP-адреса прибора коснитесь кнопки Specify an
IP address (Установить IP-адрес), введите соответствующие адресные настройки, после чего коснитесь
кнопки OK.

5. Закройте окно Network Connections (Сетевые подключения).

6. Чтобы открыть приложение Virtual CE, коснитесь на экране прибора пунктов меню Start > Programs >
Communication > Virtual CE (Пуск > Программы > Соединение > Virtual CE).

7. Коснитесь пункта Configure (Настроить) и выберите из списка элементы WAN/Internet (Глобальная
сеть/Интернет) или LAN (ЛВС). При необходимости повысить безопасность доступа прибора к сети, установите
флажок Require a password for LAN (Требовать пароль для доступа в ЛВС) и введите пароль.
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Теперь для удаленного управления прибором, получения доступа к сетевым файлам или печати при помощи
сетевого принтера можно использовать функции сети.

Сетевые функции

Для удаленного управления прибором с ПК по сети используйте программу Virtual CE. (См. стр. 57, Удаленное
управление с помощью Virtual CE.)

Смонтируйте общие сетевые диски, к которым прибор может обращаться для отправки или загрузки файлов.
Например, дважды коснитесь значка My Device (Мое устройство) на главном инструментальном экране
настольного компьютера. Затем введите в поле Address (Адрес) полный путь к сетевому диску. Возможно, при
этом вам будет предложено ввести имя пользователя, пароль и имя домена.

Перенаправьте вывод на печать на сетевой принтер. Например, выберите на приборе пункты меню File > Print
(Файл > Печать), чтобы распечатать содержимое экрана текущего измерения. Выберите PCL Laser (Лазерный
принтер под управлением PCL) в поле Printer (Принтер), Network (Сеть) в поле Port (Порт) и путь к сетевому
принтеру в поле Net Path (Сетевой путь). Возможно, при этом вам будет предложено ввести имя пользователя,
пароль и имя домена.

Войдите в Интернет при помощи веб-браузера прибора (Start > Programs > Internet Explorer (Пуск > Программы
> Internet Explorer)) Это упрощенная версия Microsoft Internet Explorer, поэтому она не обладает всеми теми
возможностями, которыми обладает версия Internet Explorer для ПК.
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Настройка параметров ActiveSync прибора

ПРИМЕЧАНИЕ. Соединение ActiveSync прибора доступно при использовании Microsoft Windows 2000 и XP.
Соединение ActiveSync прибора недоступно при использовании Microsoft Windows Vista.

1. Чтобы открыть приложение Virtual CE, коснитесь на экране прибора пунктов меню Start > Programs >
Communication > Virtual CE (Пуск > Программы > Соединение > Virtual CE).

2. Коснитесь пункта Configure (Настроить). Выберите из списка элемент ActiveSync и нажмите кнопку OK.

3. Закройте окно Virtual CE.

4. Коснитесь пунктов меню Start > Settings > Control Panel > PC Connection (Пуск > Настройки > Панель
управления > Соединение ПК). Убедитесь, что флажок Allow connection with desktop computer when device is
attached (Разрешить соединение с настольным компьютером при подключении устройства) установлен, а для
параметра Connect using (Соединение с помощью) установлено значение USB Default (USB по умолчанию).
Затем закройте диалоговое окно.

Теперь можно настроить параметры ActiveSync на ПК и использовать функции соединения ActiveSync для
удаленного управления прибором и доступа к его файлам. (См. стр. 55, Настройка ActiveSync на ПК.)

Функции соединения ActiveSync

Для удаленного управления прибором с ПК по кабелю USB используйте программу Virtual CE. (См. стр. 57,
Удаленное управление с помощью Virtual CE.)

Для открытия проводника Windows используйте кнопку ActiveSync Explorer (Проводник). Далее можно
использовать стандартные операции Windows для копирования или перемещения файлов между прибором и
ПК. Копирование файлов между прибором и ПК значительно проще осуществляется при помощи ActiveSync,
чем при помощи сетевого соединения.

Настройка ActiveSync на ПК
Регистрация порта USB прибора

Прежде чем устанавливать соединение ActiveSync между прибором и ПК, на ПК необходимо зарегистрировать порт
USB прибора SA2500 в качестве действующего порта управляемого устройства. Чтобы использовать порт USB
управляемого устройства на приборе для соединений ActiveSync, необходимо по одному разу зарегистрировать его
на каждом из ПК.

1. С помощью веб-браузера посетите сайт www.tektronix.com/software.

2. Введите SA2500 usb в поле Search by keyword (Поиск по ключевому слову).

3. Выберите ссылку USB SLAVE DEVICE PC REGISTRATION UTILITY > Software Downloads (Сервисная
программа регистрации управляемого устройства USB на ПК > загрузка программ), после чего выберите ссылку
Download File (загрузить файл).

4. Зарегистрируйтесь в средстве поиска программного обеспечения myTek, следуйте экранным инструкциям по
регистрации, затем загрузите служебную программу регистрации управляемого устройства USB на ПК.
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5. Распакуйте загруженный файл, затем дважды щелкните файл RegisterUSBSlaveDevice.exe. Следуйте
инструкциям на экране.

6. В завершение процесса регистрации порта USB включите прибор SA2500 и подсоедините кабель USB к
ПК и прибору. Обычно на ПК открывается диалоговое окно Found New Hardware Wizard (Мастер нового
оборудования). Пройдите через диалоговые окна и, если будет предложено, выберите автоматическую
установку ПО. Проследите, чтобы процесс установки завершился без сообщений об ошибках. После запуска
программы регистрации порта USB эту процедуру следует выполнить лишь один раз.

Установка и настройка Microsoft ActiveSync

Для обеспечения взаимодействия с портом USB требуется установка Microsoft ActiveSync (версии с 3.7 по 4.5). Если
на ПК не установлена соответствующая версия ActiveSync, выполните следующие действия.

1. При помощи своего веб-обозревателя войдите на веб-узел компании Microsoft и найдите страницу для загрузки
программного обеспечения ActiveSync.

2. Выберите ActiveSync версии 4.5 и следуйте инструкциям по установке ПО. Возможно, после установки ActiveSync
придется перезагрузить свой ПК.

3. Правой кнопкой мыши щелкните на панели задач ПК значок ActiveSync и выберите пункт Connection Settings
(Параметры подключения) контекстного меню. Перед нажатием кнопки OK проверьте следующие параметры.

Allow USB Connections (Разрешить соединения USB) — выбран

Allow connections to one of the following: (Разрешить соединения USB с одним из устройств:) — не выбран

This computer is connected to: (Этот компьютер соединен с) — установлено значение Automatic
(Автоматически)

Open ActiveSync when my device connects (Открывать ActiveSync, когда мое устройство соединяется)
— выбран

Установка соединения ActiveSync

1. Включите электропитание анализатора спектра SA2500.

2. После того как будет выполнена процедура запуска прибора, соедините ПК с прибором при помощи кабеля USB
(кабель типа Master–Slave). Сначала подсоедините кабель к ПК, а затем — к прибору. Программа ActiveSync
на ПК находит соединение USB и устанавливает соединение с прибором, о чем говорит появление значка
ActiveSync на панели задач ПК.

3. Чтобы проверить соединение ActiveSync, откройте приложение ActiveSync и щелкните кнопку Explore
(Просмотреть) на панели инструментов. ActiveSync открывает диалоговое окно проводника Windows, в котором
отображается верхний уровень папок прибора. Проводник Windows можно использовать для перехода к файлам
прибора и их выбора с целью копирования или перемещения.

4. Теперь также можно использовать Virtual CE для удаленного управления прибором через соединение ActiveSync.
(См. стр. 57, Удаленное управление с помощью Virtual CE.)
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Удаленное управление с помощью Virtual CE
Virtual CE — это программа, обеспечивающая удаленный доступ к экрану прибора SA2500. Для воздействия на
элементы управления виртуального экрана прибора с целью управления удаленным прибором или доступа к его
рабочему столу используется мышь ПК. Программа Virtual CE на приборе уже установлена; далее описывается
процедура установки Virtual CE на ПК.

Установка и настройка Virtual CE на ПК

ПРИМЕЧАНИЕ. Программа Virtual CE, установленная на приборе SA2500, не может осуществлять связь с
компьютером непосредственно через кабель USB, поскольку выбор соединения USB в списке конфигурации
программы отсутствует. Однако Virtual CE на приборе SA2500 поддерживает соединение ActiveSync, которое
может использовать кабель USB.

Компьютерная версия Virtual CE поддерживает соединение ActiveSync. Однако выбор ActiveSync в Virtual CE
невозможен при использовании ОС Microsoft Windows Vista. Поэтому программу ActiveSync можно использовать
для установления связи с прибором посредством кабеля USB только в ОС Microsoft Windows 2000 или XP.

1. С помощью веб-браузера посетите сайт www.tektronix.com/software.

2. Введите virtualce в поле Search by keyword (Поиск по ключевому слову).

3. Выберите ссылку VIRTUALCE PC APPLICATION INSTALLATION FILE > Software Downloads (Установочный
файл приложения Virtual CE для ПК > Загрузка программ), после чего выберите ссылку Download File (Загрузить
файл).

4. Зарегистрируйтесь, следуя экранным инструкциям, и загрузите служебную программу Virtual CE.

5. Распакуйте загруженный файл, затем дважды щелкните файл Install_VirtualCE.exe. Следуйте инструкциям
на экране.

6. Для запуска программы последовательно выберите пункты меню Start > Programs > Tektronix > Virtual CE >
Virtual CE (Пуск > Программы > Tektronix > Virtual CE > Virtual CE).

7. Щелкните кнопку Configure (Настроить) и выберите приемлемый тип соединения (LAN, WAN/Internet или
ActiveSync (ЛВС, глобальная сеть/Интернет или ActiveSync)).

Запуск программы Virtual CE на приборе и на ПК

1. Убедитесь в наличии работающего удаленного соединения Ethernet или ActiveSync/USB между ПК и прибором
SA2500.

2. Последовательно коснитесь на приборе пунктов меню Start > Programs > Communication > Virtual CE (Пуск
> Программы > Соединение > Virtual CE). Коснитесь кнопки Configure (Настроить) и проследите, чтобы был
выбран надлежащий тип соединения (ЛВС, глобальная сеть/Интернет или ActiveSync).

3. В нижней части экрана прибора на панели задач коснитесь кнопки Virtual CE, чтобы минимизировать экран
Virtual CE.

4. Последовательно щелкните на ПК пункты меню Start > Programs > Tektronix > Virtual CE > Virtual CE (Пуск >
Программы > Tektronix > Virtual CE > Virtual CE). Нажмите кнопку Configure (Настроить) и убедитесь, что выбран
тот же тип соединения, что и при выполнении шага 2. При использовании сетевого соединения проверьте
правильность IP-адреса, указанного над кнопкой Configure (Настроить). Программа Virtual CE компьютера
должна установить соединения с прибором и отобразить экран прибора в окне Virtual CE на ПК.
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5. Чтобы воспользоваться возможностью удаленного управления приложением прибора SA2500, в окне Virtual CE
на ПК запустите приложение SA2500 (если оно еще не запущено). Прибор запускает это приложение, и в окне
Virtual CE на ПК отображается его интерфейс. Теперь можно управлять всеми функциями прибора, оперируя
элементами управления прибора с ПК при помощи мыши.

6. Чтобы закрыть удаленный доступ, выйдите из приложения Virtual CE, как на приборе, так и на компьютере, в
произвольном порядке. Или отсоедините кабель Ethernet или USB от прибора.
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Технические характеристики

Технические характеристики

В этом разделе перечислены электрические, экологические и физические характеристики анализатора спектра
SA2500. Все приведенные технические характеристики являются гарантированными, за исключением отмеченных
комментарием «Типичное значение». Типичные характеристики приводятся для удобства, но их фактические
значения могут отличаться от указанных.

Таблица 1: Основные рабочие характеристики

Характеристика Описание

Вход РЧ-сигнала

Рабочий диапазон
частот

10 кГц–6,2 ГГц

Рабочий диапазон в некоторых случаях может быть ограничен. Если это так,
ограниченный диапазон определяется для соответствующего случая.

Максимальный
уровень рабочего
входного сигнала

20 дБм для максимального значения мощности огибающей.

Это максимальный уровень входного сигнала, при котором прибор должен
соответствовать предъявляемым к нему техническим требованиям.

Для сигнала без изменения амплитуды максимальное значение мощности огибающей =
RMS (среднеквадратичному значению).

Максимальная
мощность входного
сигнала без
повреждения

50 Вт эфф. ниже 3,2 ГГц

15 Вт эфф. между 3,2 и 6,2 ГГц

Выходной ПЧ-сигнал

Выходной импеданс 50 Ом

Центральная
частота ПЧ-сигнала

140 МГц, не инвертированный

Полоса
пропускания 3 дБ
ПЧ-сигнала

24 МГц номинал

Уровень выходного
ПЧ-сигнала

–12 дБм при 1,0 ГГц
–12 дБм при 1,2 ГГц
–10 дБм при 1,6 ГГц
–11 дБм при 4,35 ГГц
–16 дБм при 5,0 ГГц
–22 дБм при 5,75 ГГц

подаваемый на вход немодулированный сигнал 0 дБм, опорный уровень прибора
установлен на 0 дБм, комнатная температура.

Точность уровня
выходного ПЧ-сигнала,
типичное значение

± 3,5 дБ для немодулированного входного сигнала, входной сигнал 0 дБм, частота
входного сигнала 1 ГГц, опорный уровень 0 дБм, комнатная температура

Неравномерность
выходного ПЧ-сигнала,
типичное значение

± 1,5 дБ до ± 3 МГц от центральной частоты
± 3 дБ до ± 10 МГц от центральной частоты

Внутренняя временная развертка
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Технические характеристики

Таблица 1: Основные рабочие характеристики (прод.)

Ошибка, с поправкой на
заводскую калибровку

± 0,5 промилле от 0 до 50 °C
± 1,0 промилле приработки/год

Для достижения точности измерений, соответствующей паспортным характеристикам,
необходим двадцатиминутный прогрев.

Ошибка, с поправкой
на GPS, типичное
значение

± 0,01 промилле

Ошибка, после
потери привязки GPS,
типичное значение

± 0,03 промилле, 10-минутный интервал после потери привязки (работа прибора свыше
20 минут до потери привязки, изменение температуры менее ± 5 °C на протяжении
интервала)

Внешний опорный входной сигнал

Сопротивление 1500 Ом

Диапазон частот 1–20 МГц ± 1 промилле c шагом 1 МГц

Диапазон уровня
входного сигнала

От –15 дБм до +15 дБм, 1–15 МГц
От –10 дБм до +15 дБм, 16–20 МГц

уровни дБм предполагают источник сопротивлением 50 Ом

Синхронизация

Режим регистрации Единичный или непрерывный, без синхронизации или с синхронизацией

Синхронизация выключена во время измерений в режимах Audio Demod (Звуковая
демодуляция), Signal Strength (Сила сигнала) и DPX.

Источник
синхронизации

Уровень ПЧ, внешний входной сигнал или внутренняя временная развертка

Типы синхронизации Синхронизация по нарастающему или нисходящему фронту, выше или ниже порогового
уровня.

Задержка
синхронизации

Диапазон: 0–60 секунд

Разрешение: 1 мкс

Положение точки
синхронизации

Диапазон: от 0 до 100%

Разрешение: 1%

Синхронизация по
уровню ПЧ

При синхронизации по уровню ПЧ амплитуда мощности оцифрованного потока данных
во временном интервале сравнивается с установленным пороговым значением.

Порог
синхронизации

Диапазон: От –160 дБм до +20 дБм

Разрешение: 1 дБ
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Таблица 1: Основные рабочие характеристики (прод.)

Диапазон полосы
пропускания
синхронизации

5 кГц–20 МГц в последовательности 1, 2, 5
10 МГц < диапазон ≤ 20 МГц: полоса пропускания синхронизации = 20 МГц
5 МГц < диапазон ≤ 10 МГц: полоса пропускания синхронизации = 10 МГц
2 МГц < диапазон ≤ 5 МГц: полоса пропускания синхронизации = 5 МГц
1 МГц < диапазон ≤ 2 МГц: полоса пропускания синхронизации = 2 МГц
500 кГц < диапазон ≤ 1 МГц: полоса пропускания синхронизации = 1 МГц
200 кГц < диапазон ≤ 500 кГц: полоса пропускания синхронизации = 500 кГц
100 кГц < диапазон ≤ 200 кГц: полоса пропускания синхронизации = 200 кГц
50 МГц < диапазон ≤ 100 кГц: полоса пропускания синхронизации = 100 кГц
20 кГц < диапазон ≤ 50 кГц: полоса пропускания синхронизации = 50 кГц
10 кГц < диапазон ≤ 20 кГц: полоса пропускания синхронизации = 20 кГц
5 кГц < диапазон ≤ 10 кГц: полоса пропускания синхронизации = 10 кГц
2,5 кГц < диапазон ≤ 5 кГц: полоса пропускания синхронизации = 5 кГц

Только в режиме измерения спектра: диапазон ≤ 2,5 кГц: полоса пропускания
синхронизации = 2,5 кГц

Характеристики
входного сигнала
внешнего запуска
функции Timing/Trigger (
синхронизации/запуска)

Импеданс: 10 кОм
Минимальное значение верхнего порога: 2,0 В
Максимальное значение нижнего порога: 0,8 В
Минимальное значение верхнего предела времени: 10 нс
Минимальное значение нижнего предела времени: 10 нс
Максимальный уровень входного сигнала без повреждения: ±5 В пик, непрерывный
режим
Тип входа: прямой

Синхронизация с
внутренней временной
разверткой

При синхронизации с внутренней временной разверткой создается событие
синхронизации в заданное пользователем время.

Временные режимы
синхронизации

Однократный запуск синхронизации по времени

Повторение синхронизации с интервалом

Оба (синхронизация по времени и интервал повтора)

Время
синхронизации

Единицы измерения: часы, минуты, секунды, микросекунды

Диапазон: от 0 до 23:59:59.999999

Разрешение: 1 мкс

Интервал повтора Единицы измерения: секунды, микросекунды

Диапазон: от 0 до 600,999999 c

Разрешение: 1 мкс

Временные метки результатов измерений

Значение отметки
времени

Единицы измерения: годы, месяцы, дни, часы, минуты, секунды, мс/нс

Разрешение: 1 мс, до получения первой привязки GPS, 1 нс, после получения первой
привязки GPS

Точность, данные GPS,
типичное значение

± 1000 нс, все измерения, кроме спектра DPX

± 1 мс, спектр DPX

Получена внутренняя привязка GPS

Точность,
относительная,
типичное значение

± 500 нс

Получена внутренняя привязка GPS

Идентичная настройка диапазона (AcqBW) требуется для результатов измерений.
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Таблица 1: Основные рабочие характеристики (прод.)

Координаты GPS

Частота обновления
координат

1 обновление в секунду

Единицы измерения
координат

Широта/долгота: градусы, минуты, секунды

Высота над уровнем моря: метры

Разрешение координат Широта/долгота: 0,001 секунды

Высота над уровнем моря: 0,01 метра

Точность координат По горизонтали: R < 9 метров (P = 90 %)

Высота над уровнем моря: H < 18 метров (P = 90 %)

Где P — это процент полученных координат, находящихся в пределах горизонтального
радиуса в R метров и в пределах вертикального расстояния +/-H метров от точного
расположения координат.

Таблица 2: Характеристики анализатора спектра

Характеристика Описание

Центральная частота диапазона

Диапазон 10 кГц–6,2 ГГц, предусилитель выключен

10 МГц–6,2 ГГц, предусилитель включен

Разрешение
настройки

1 Гц

Диапазон

Диапазон От 1 кГц до 6,2 ГГц

Разрешение
настройки

1 Гц

Полоса пропускания разрешения

Диапазон 10 Гц - 3 МГц (ручная установка разрешения по полосе пропускания)
10 Гц–1 МГц (автоматическая установка разрешения по полосе пропускания)

Разрешение
настройки

1 Гц

Спектральная чистота

Отображаемый
средний
уровень шума,
предусилитель
включен

–153 дБм, 10 МГц–2 ГГц, разрешение по полосе пропускания 10 Гц
–152 дБм, 2–4 ГГц, разрешение по полосе пропускания 10 Гц
–151 дБм, 4–5 ГГц, разрешение по полосе пропускания 10 Гц
–145 дБм, 5–6,2 ГГц, разрешение по полосе пропускания 10 Гц
Опорный уровень ≤ (отображаемый средний уровень шумов (DANL) + 90 дБ)

Фазовый шум ≤ –95 дБн/Гц при смещении 10 кГц
≤ –95 дБн/Гц при смещении 20 кГц
≤ –95 дБн/Гц при смещении 30 кГц
≤ –97 дБн/Гц при смещении 100 кГц
≤ –110 дБн/Гц при смещении 1 МГц
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Таблица 2: Характеристики анализатора спектра (прод.)

Остаточные
паразитные
сигналы,
предусилитель
выключен

≤ –90 дБм, установка аттенюатора 0 дБм

Исключаемые частоты:
центральная частота диапазона 9–19 МГц
центральная частота 3 464 МГц
центральная частота 4 592 МГц
центральная частота диапазона 5374–5378 МГц
центральная частота 6 160 МГц

Остаточные
паразитные
сигналы,
предусилитель
включен

≤ –105 дБм, установка аттенюатора 0 дБм

Исключаемые частоты:
центральная частота диапазона 9–19 МГц
центральная частота диапазона 5374–5378 МГц

Интермодуляци-
онное искажение
третьего порядка

≤ –70 дБн для двух звуковых сигналов на опорном уровне или ниже, предусилитель
выключен, все параметры усиления автоматически взаимосвязаны

Вторая гармоника ≤ –60 дБн для одного звукового сигнала на опорном уровне или ниже него,
предусилитель выключен, все параметры усиления автоматически взаимосвязаны

Паразитные
входные сигналы

≤ –70 дБн, за исключением Fin = 2,282 ГГц ± 20 МГц

Опорным значением для величины «дБн» данной спецификации является суммарная
мощность всех сигналов, поступающих на вход прибора, независимо от величины
текущего диапазона.

Паразитные
входные сигналы,
исключаемые
частоты, типичные
значения

≤ -55 дБн, за исключением Fin = 2,282 ГГц ± 20 МГц

Опорным значением для величины «дБн» данной спецификации является суммарная
мощность всех сигналов, поступающих на вход прибора, независимо от величины
текущего диапазона.

Перехват
составляющих
третьего порядка

≥ +7 дБм, ослабление входного сигнала 0 дБ, предусилитель выключен
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Таблица 2: Характеристики анализатора спектра (прод.)

Амплитуда спектра сигнала

Диапазон и
единицы опорного
уровня

Диапазон: От +20 дБм до -160 дБм

Единицы измерения: дБм, дБмВ, дБмкВ, дБВ, дБВт, В, Вт

Погрешность
мощности маркера

±1,75 дБ, –50 дБм ≤ входной сигнал ≤ +20 дБм, предусилитель выключен

±3,0 дБ, –80 дБм ≤ входной сигнал < –50 дБм, предусилитель включен, выше 10 МГц

±3,75 дБ, –120 дБм ≤ входной сигнал < –80 дБм, предусилитель включен, выше 10 МГц

Для сигналов, подобных незатухающей гармонической волне, используйте пиковый
детектор; для широкой полосы частот (сигнал >> разрешение по полосе пропускания)
используйте усредняющий детектор

Погрешность гарантирована для сигналов, подобных незатухающей гармонической
волне, и для диапазона, установленная ширина которого составляет 20 МГц или менее

Дисплей

Режимы
отображения

Normal (нормальный) — экран обновляется после получения каждого нового результата
Max Hold (с запоминанием максимума) — отображаемая точка обновляется только в
том случае, если ее новое значение > старого значения
Min Hold (с запоминанием минимума) — отображаемая точка обновляется только в том
случае, если ее новое значение < старого значения
Max/Min Hold (с запоминанием максимума и минимума) — между точкой, отображаемой
в режиме Max Hold (запоминание максимума), и точкой, отображаемой в режиме Min
Hold (запоминание минимума), отображается вертикальная полоса
Average (среднее значение) — отображается среднее из N (определяется
пользователем) измеренных значений

Среднее значение рассчитывается следующим образом:

Последние N значений сохраняются в памяти; когда появляется новое измеренное
значение, самое раннее значение отбрасывается, новое значение добавляется к
сохраненным, и на основе сохраненных значений рассчитывается уже новое среднее
значение
Если число результатов измерений меньше N, то все результаты усредняются вместе

Количество средних
значений

1 ≤ N ≤ 200

Таблица 3: Характеристики процесса обработки измерений DPX

Характеристика Описание

Частота обработки
спектра, типичное
значение

2500 в секунду (независимо от диапазона)

Приборы с опцией EP1: 10 000 в секунду (независимо от диапазона)

Минимальная
длительность сигнала
для 100 % вероятности
перехвата, типичное
значение

500 мкс

Приборы с опцией EP1: 125 мкс

Ширина диапазона 5 кГц–20 МГц

Настройки разрешения
по полосе пропускания

Разрешение по полосе пропускания = Диапазон/200
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Таблица 4: Характеристики РЧ-измерений общего назначения

Характеристика Описание

Измерение мощности РЧ-канала общего назначения

Диапазон
измеряемых частот

1 кГц–20 МГц

Точность ≤1,2 дБ; от +20 до –60 дБм; разрешение по полосе пропускания < 100 кГц
От +20 до –40 дБм; разрешение по полосе пропускания ≥ 100 кГц
от 1 МГц до 3,2 ГГц, предусилитель выключен

≤ 2,4 дБ; от –60 до –75 дБм; разрешение по полосе пропускания < 100 кГц
От –40 до –55 дБм; разрешение по полосе пропускания ≥ 100 кГц
от 10 МГц до 3,2 ГГц, предусилитель включен

≤ 1,8 дБ; от +20 до –50 дБм; разрешение по полосе пропускания < 100 кГц
От +20 до –40 дБм; разрешение по полосе пропускания ≥ 100 кГц
от 3,2 до 6,2 ГГц, предусилитель выключен

≤ 3 дБ; от –50 до –75 дБм; разрешение по полосе пропускания < 100 кГц
От –40 до –55 дБм; разрешение по полосе пропускания ≥ 100 кГц
от 3,2 до 6,2 ГГц, предусилитель включен

Характеристики относятся к настройкам управления, принимаемым по умолчанию
(автонастройка полосы пропускания разрешения, автонастройка уровня)

Измерение ширины занимаемой полосы частот

Диапазон
включения
мощности в
процентах

50–100 % с шагом 1 %
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Таблица 4: Характеристики РЧ-измерений общего назначения (прод.)

Напряженность РЧ-поля

Ширина полосы
пропускания канала

Та же самая, что и у мощности канала

Точность Та же самая, что и у мощности канала

Таблица 5: Характеристики временной зависимости амплитуды

Характеристика Описание

Центральная частота диапазона

Диапазон Минимальная центральная частота = 10 кГц + диапазон/2, предусилитель выключен

Минимальная центральная частота = 10 МГц, предусилитель включен

Максимальная центральная частота = 6,2 ГГц

Разрешение 1 Гц

Диапазон

Диапазон 5 кГц–20 МГц в последовательности 1, 2, 5

Частота выборки устанавливается автоматически исходя из выбора ширины диапазона

66 Руководство по эксплуатации SA2500



Технические характеристики

Характеристика Описание

Длина записи

Диапазон 1024–1024000 выборок

от 36 мкс до 149 с, в зависимости от ширины диапазона и числа выборок

Выбор ширины диапазона и числа выборок определяет длину записи

Частота выборки устанавливается автоматически исходя из выбора ширины диапазона

Отображение временной зависимости амплитуды

Диапазон и единицы
опорного уровня

От +20 дБм до -160 дБм

дБм, дБмВ, дБмкВ, дБВ, дБВт, В, Вт

Погрешность мощности
маркера

±1,8 дБ, –50 дБм ≤ входной сигнал ≤ +20 дБм, предусилитель выключен

±3,0 дБ, –75 дБм ≤ входной сигнал < –40 дБм, предусилитель включен, выше 10 МГц

Дисплей

Типы детекторов Average (среднее значение): одна точка на дисплее представляет собой среднее по
группе точек данных значение
+Peak (положительный пик): одна точка на дисплее представляет собой максимальное
из группы точек данных значение
–Peak (отрицательный пик): одна точка на дисплее представляет собой минимальное из
группы точек данных значение
+Peak/–Peak (положительный/отрицательный пик): одна вертикальная линия на дисплее
представляет собой диапазон между максимальным и минимальным значениями группы
точек данных

Типы кривых Normal (нормальная): экран обновляется после каждого нового результата
Max Hold (с запоминанием максимума): отображаемая точка обновляется только в том
случае, если ее новое значение > старого значения

Min Hold (с запоминанием минимума): отображаемая точка обновляется только в том
случае, если ее новое значение < старого значения
Max/Min Hold (с запоминанием максимума и минимума): между точкой, отображаемой в
режиме Max Hold (запоминание максимума), и точкой, отображаемой в режиме Min Hold
(запоминание минимума), отображается вертикальная полоса
Average (среднее значение): отображается среднее из N (определяется пользователем)
измеренных значений

Количество средних
значений

1 ≤ N ≤ 200

Экспорт данных I/Q Данные I/Q могут экспортироваться в следующие форматы:
IQT: синфазные и сдвинутые по фазе на 90 градусов данные для последующей
обработки программой RSAVu
CSV: разделенные запятыми значения в формате ASCII
MAT: файл совместимого с Matlab® формата

Таблица 6: Характеристики анализа и мониторинга сигнала

Характеристика Описание

Амплитудная
демодуляция

Выдает на выходе звуковой сигнал после амплитудной демодуляции выбранного
пользователем сигнала

Измеряемая
частота

Ранее выбранная
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Таблица 6: Характеристики анализа и мониторинга сигнала (прод.)

Минимальный
уровень входного
сигнала, типичное
значение

-100 дБм

Измеряемая полоса
частот звукового
сигнала

8 кГц

Частотная
демодуляция

Выдает на выходе звуковой сигнал после частотной демодуляции выбранного
пользователем сигнала

Измеряемая
частота

Ранее выбранная

Минимальный
уровень сигнала,
типичное значение

-100 дБм

Максимальный
уход сигнала

До 100 кГц

Измеряемая полоса
частот звукового
сигнала

8 кГц, 15 кГц, 75 кГц или 200 кГц

Максимальная
полоса частот
выходного
звукового сигнала

15 кГц

Индикатор силы
сигнала

Выдает звуковой тоновый сигнал и выводит на экран визуальный индикатор, которые
зависят от силы выбранного пользователем сигнала

Уровень входного
сигнала

минимум –120 дБм

Измеряемая
частота

Ранее выбранная

Измеряемая полоса
частот

До 20 МГц в зависимости от установки диапазона и полосы пропускания разрешения

Тип тонового
сигнала

Переменная скорость подачи звуковых сигналов или переменная частота

Скорость
обновления,
типичное значение

10 в секунду
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Таблица 7: Характеристики окружающей среды

Характеристика Описание

Температура При эксплуатации: от 0 до +50 °C, номинальная характеристика, от –10 до +50 °C,
типичная

При хранении: От -40 ℃ до +60 ℃
Приведенные выше температурные характеристики изменяются с установкой
следующих дополнительных элементов:

Литиево-ионные батареи: заряд от 0 до +45 °C, хранение от –20 до +60 °C

Влажность Рабочая и при хранении: относительная влажность от 5 до 95 % при температуре до
30 °C, от 5 до 45 % при температуре от 30 до 50 °C, без конденсации

Высота над уровнем
моря

При эксплуатации: до 4 600 м

При хранении: до 12 192 метров

Таблица 8: Физические характеристики

Характеристика Описание

Размеры Высота: 25,5 см

Ширина: 33 см

Глубина: 12,5 см

Масса 6,0 кг прибор и одна батарея

Таблица 9: Прочие характеристики

Характеристика Описание

Рекомендуемый
интервал калибровки
прибора

2 года
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Предметный указатель

Символы и цифры
? кнопка, 16

А
Автоматические измерения при

помощи программы iMap, 45
Адаптер переменного тока,

подключение, 3
Адаптер, переменный ток,

подключение, 3
Активный приемник GPS

(определение), 40

Б
Батарея

время зарядки, 4
зарядка, 4
обслуживание и

обращение, 5
расположение дверцы

отсека, 9
состояние заряда, 9
установка, 2

В
Ввод чисел в поля, 15
Взаимный обмен файлами

прибора и ПК, 53
Включение

стандарты сигнала, 17
типы сигнала, 17

Включение (электропитания), 5
Внешний усилитель входного

РЧ-сигнала, 12
Вход внешнего опорного

синхросигнала, 10
Вход микрофона, 10
Вход РЧ-сигнала

кнопка усиления/ослабления
сигнала, 12

характеристики, 2
Выбор типа измерения, 18
Выключение (электропитания), 5
Выходной ПЧ-сигнал

включение, 28
советы по использованию, 29

Г
Графическая карта (iMap), 40
Гроза, предотвращение травм, xi
Грозы, предотвращение травм, xi

Д
Декларация зоны (классификация

сигнала), 37
Декларировать

декларировать зону, 37
Неизвестный, 37
Неразрешенный, 37
Нет, 37
Разрешенный, 37

Детали прибора, 9
Диапазон, 19
Диапазон частот (Спектр), 19
Добавление стандартов сигнала в

списки выбора, 17
Добавление типов сигнала в

списки выбора, 17
Документация, viii
Дополнительные возможности для

измерений, x
Дополнительные возможности

для измерений с помощью
прибора, x

Дополнительные возможности,
программа/измерение, x

З
Загрузить сводку зон

(классификация сигнала), 39
Загрузка файла карты (iMap), 41
Запуск SA2500, 7
Зарядка батарей, 4
Зона

загрузить сводку
профилей, 39

определение зоны, 33
редактирование зоны, 35
сводка профилей, 38
сохранить сводку

профилей, 39

И
Изменение

цвета экрана приложения для
печати, 8

числа в полях, 15
Изменить

диапазон частот спектра, 19
Измерение

выбор отображаемого
измерения, 18

изобразить стрелку,
указывающую
направление измерения
(iMap), 44

кнопка состояния опорной
частоты, 12

кнопки режимов, 11, 15
кнопки управления

отображением, 13
панели, 11
привязка измерения к месту

на карте (iMap), 41
просмотреть результаты

помеченного значком
iMap измерения, 43

типы значков iMap, 43
удалить стрелку,

указывающую
направление измерения
(iMap), 45

экран результатов, 11
Измерение спектра, 19
Измерения iMap с регистрацией

большого количества
данных, 45

Изображение стрелки,
указывающей направление
измерения (iMap), 44

Интерактивная справка, 16
Использование сенсорного

экрана, 6

К
Калибровка сенсорного экрана, 6
Карта с координатной сеткой

(iMap), 40
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Классификация сигнала
декларировать зону, 37
загрузить сводку

профилей, 39
Неизвестный, 37
Неразрешенный, 37
Нет, 37
определение зоны, 33
Разрешенный, 37
редактирование зоны, 35
сводка профилей, 38
сохранить сводку

профилей, 39

Кнопка
включение/ожидание, 9
измерения с регистрацией

большого количества
данных (iMap), 45

измерения iMap с
регистрацией большого
количества данных, 45

измеряемая частота, 13
кнопки режимов

измерений, 15
масштабирование, 13
отмена действия с

отображением, 13
отображение маркеров, 13
Пауза, 11
передняя кривая, 13
перемещение

отображения, 13
Пуск, 11
режим измерения спектра, 15
режим измерения

спектрограммы, 15
Режим привязки к карте

iMap, 15
сброс, 9
сброс измерения, 13
состояние опорной частоты

измерения, 12
состояние GPS, 11
спектрограмма, 13
справка, 16
Справка, 11
усиление/ослабление

входного РЧ-сигнала, 12
Частота, 19
AutoLevel (Автоуровень), 12,

19
F EXT (ЧАСТОТА ВНЕШ.), 12
F GPS (ЧАСТОТА GPS), 12
F INT (ЧАСТОТА ВНУТ.), 12
Ref Level (Опорный

уровень), 12, 19
span (диапазон), 13

Кнопка для пуска измерений
с регистрацией большого
количества данных (iMap), 45

Кнопка масштабирования, 13
Кнопка отмены действия с

отображением, 13
Кнопка отображения маркеров, 13
Кнопка передней кривой, 13

Кнопка перемещения отображения
сигнала, 13

Кнопка сброса, 9
Кнопка сброса измерения, 13
Кнопка состояния GPS., 11
Кнопка AutoLevel

(Автоуровень), 12
Кнопка Freq (Частота), 13
Кнопка Keypad (Клавиатура), 15
Кнопка Pause (Пауза), 11
Кнопка Ref Level (Опорный

уровень), 12
Кнопка Run (Пуск), 11
Кнопки панели, 13
Кнопки Span (Диапазон), 13
Командная строка, 11
Концепции файлов карт (iMap), 40

М
Максимальная настройка

(DPX), 25
Масса, 1
Меню, 11
Методы удаленного доступа, 53
Минимальная настройка

(DPX), 25
Молния, предотвращение

травм, xi

Н
Нанесение места проведения

измерений (iMap), 41
Настройка

отображаемые цвета, 8
стандарты сигнала, 17
типы сигнала, 17

Настройка аттенюатора (входной
РЧ-сигнал), 12

Настройка внешнего аттенюатора
входного РЧ-сигнала, 12

Настройка сетевых параметров
прибора, 53

Настройка усилителя (входной
РЧ-сигнал), 12

О
Обзор (iMap), 39
Обновления программного

обеспечения, x
Обновления, программное

обеспечение, x
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Общие положения о
безопасности, iii

Общие элементы управления
измерениями, 12

Определение
активный приемник GPS, 40
графическая карта, 40
карта с координатной

сеткой, 40
Определение зоны классификации

сигнала, 33
Основные понятия (сенсорный

экран), 6
Основные функции, viii
Основы работы, 17
Открытие SA2500, 7
Отображение

осциллограмма спектра, 19
состояние

включения/выключения
электропитания, 9

Отображение спектра DPX, 23
Отображение спектрограммы, 21

П
Панель состояния, 9
Перемещение значка измерения

(iMap), 42
Подключение адаптера

переменного тока, 3
Подключение адаптера

переменного/постоянного
тока, 9

Поле Intensity (Интенсивность)
(DPX), 24

Получение справки, 16
Пользовательский интерфейс

измерительные панели, 11
кнопки режимов

измерений, 11
командная строка, 11
меню, 11
обзор, 11
цветовые схемы, 8
экран результатов

измерений, 11
элементы управления

анализатором
спектра, 11

Порт USB прибора, регистрация
на ПК, 55

Порты PCMCIA, 9
Последовательный порт

RS-232, 10
Послесвечение (DPX), 23
Послесвечение точки (DPX), 24
Предотвращение травм от удара

молнии, xi
Преобразование карт в формат

GSF, 49
Привязка измерения к месту на

карте, 41
Принадлежности

(стандартные), 1
Проверка работоспособности, 5
Проверка работоспособности

прибора, 5
Программа преобразования

файлов карт, 49
Программное обеспечение, ix
Программное обеспечение ПК, ix
Программное обеспечение

прибора, ix
Просмотр записи

спектрограммы, 22
Просмотреть содержимое

помеченного значком
измерения (iMap), 43

Процент событий (DPX), 23, 25

Р
Размеры, 1
Разъем для клавиатуры PS/2, 10
Разъем для локальной сети

Ethernet (RJ-45), 10
Разъем для наушников, 10
Разъем FREQ REF IN (ОПОРНАЯ

ЧАСТОТА ВХ.), 10
Разъем GPS, 10
Разъем IF OUT (ПЧ ВЫХ.), 10
Разъем RF IN (РЧ ВХ.), 10
Разъем TRIGGER/TIMING IN

(ЗАПУСК/СИНХРОНИЗАЦИЯ
ВХ.), 10

Разъем USB Host, 10
Разъем USB Slave, 10

Разъемы
вход и выход, 10
вход/выход сигнала, 10
FREQ REF IN (ОПОРНАЯ

ЧАСТОТА ВХ.), 10
GPS, 10
IF OUT (ПЧ ВЫХ.), 10
RF IN (РЧ ВХ.), 10
TRIGGER/TIMING IN (ЗАПУ-

СК/СИНХРОНИЗАЦИЯ
ВХ.), 10

Разъемы входа/выхода, 10
Разъемы для входных сигналов

Вход опорной частоты, 10
Вход РЧ-сигнала, 10
TRIGGER/TIMING IN (ЗАПУ-

СК/СИНХРОНИЗАЦИЯ
ВХ.), 10

Разъемы прибора, 9
Распаковка прибора, 1
Расположение портов

ввода-вывода, 9
Регистрация порта USB

прибора, 55
Редактирование зоны

классификации сигнала, 35

С
Сенсорный экран

калибровка, 6
основные понятия, 6
состояние включения/выклю-

чения, 9
Синхронизация

включение, 30
советы по использованию, 31

Состояние
электропитания/дисплея, 9

Сохранить сводку зон
(классификация сигнала), 39
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Спектр
вкладки параметров, 20
кнопка режима измерения, 15
кнопки управления

отображением, 13
основные элементы

управления, 11
отображение

осциллограммы, 19
установить диапазон

частот, 19
установить опорный

уровень, 19
установка других параметров

спектра, 20
установка измеряемой

частоты, 19
Спектр DPX

Вкладка Bitmap (Точечный
рисунок), 24

как отобразить, 23
кнопки управления

отображением, 13
Максимальная настройка, 25
Минимальная настройка, 25
обзор, 23
Поле Intensity

(Интенсивность), 24
Послесвечение, 23
Послесвечение точки, 24
Процент событий, 23, 25
Точечный рисунок, 23
Установка бесконечного

послесвечения, 24, 25
Установка переменного

послесвечения, 24
Спектрограмма

двойное отображение спектра
и спектрограммы, 21

как отобразить, 21
кнопка отображения

спектрограммы, 13
просмотр записи данных, 22

Справка
доступ к интерактивной

справке, 16
кнопка, 11

Стандартные принадлежности, 1
Стандарты сигнала

включение, 17
добавление стандартов

сигнала в списки
выбора, 17

Стрелка, указывающая
направление (iMap), 44

Т
Технические характеристики, 59
Типы сигнала

включение, 17
добавление типов сигнала в

списки выбора, 17
Точечный рисунок (DPX), 23
Требования к адаптеру

переменного тока, 1
Требования к входному

напряжению, 1
Требования к рабочему диапазону

температур, 1
Требования по влажности, 2
Требования по высоте, 2

У
Удалить значки измерений

(iMap), 43
удалить стрелку, указывающую

направление (iMap), 45
Удалить стрелку, указывающую

направление (iMap), 45
Указательная стрелка, как удалить

(iMap), 45
Условия эксплуатации, 1
Условные обозначения в данном

руководстве, x
Установка аккумуляторных

батарей, 2
Установка бесконечного

послесвечения (DPX), 24, 25
Установка других параметров

спектра, 20
Установка переменного

послесвечения (DPX), 24

Ф
Файл карты формата ArcInfo Shape

(.shp), 49
Файл карты формата MapInfo

Interchange Format (.mif), 49
Файл карты формата USGS Digital

Line Graph (.opt), 49
Файл точечной графики (iMap), 40
Функции прибора, viii

Х
Характеристики входного

сигнала, 2

Ц
Цвета экрана, 8
Цветовая схема для работы в

помещении, 8
Цветовая схема для работы вне

помещения, 8
Цветовые схемы

(пользовательский
интерфейс), 8

Ч
Чистка прибора, 2
Чистка прибора и сенсорного

экрана, 2
Чистка сенсорного экрана, 2

Э
Электропитание

включение и выключение
электропитания
прибора, 5

Кнопка On/Standby (Включен-
ие/ожидание), 9

панель состояния, 9
Требования к адаптеру

переменного тока, 1
Элемент управления Increment

(Пошаговое изменение), 15
Элементы прибора, 9
Элементы управления вводом

параметров, 15
Элементы управления областью

ввода, 15

A
ActiveSync

настроить параметры
прибора, 55

проверить поддерживаемую
версию, 56

установить и настроить на
ПК, 56

установить соединение, 56
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Предметный указатель

B
BMP, 40

G
GPS и карты, 40
GPS, активный, определение, 40
.gsf, 40
GSF, 40
GSF, преобразование карт, 49

I
iMap

выполнение автоматических
измерений с привязкой к
карте, 45

загрузка файла карты, 41
значки измерений,

удалить, 43
изменить направление

стрелки, указывающей
направление
измерения, 44

измерений с регистрацией
большого количества
данных, 45

изобразить стрелку,
указывающую
направление
измерения, 44

кнопка для пуска измерений с
регистрацией большого
количества данных, 45

кнопка режима привязки к
карте, 15

концепции файлов карт, 40
нанесение места измерения

на карту, 41
обзор, 39
перемещение значка

измерения, 42
преобразование карт, 49
привязка измерения к месту

на карте, 41
просмотреть результаты

помеченного значком
измерения, 43

пуск режима iMap, 39
типы значков, 43
типы значков измерений, 43
удалить значки

измерений, 43
удалить стрелку,

указывающую
направление, 45

iMap Converter, 49

M
.mif, 40
MIF, 40

S
Survey summary (классификация

сигнала), 38

V
Virtual CE

загрузить, установить,
настроить, 57

запуск на ПК, 57
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